
ACHIEVEMENT 
TEST



Meaning:

An achievement test is a test of developed skill
or knowledge. The most common type of
achievement test is a standardized test developed
to measure skills and knowledge learned in a
given grade level, usually through planned
instruction, such as training or classroom
instruction.



USES OF ACHIEVEMENT TEST

• Achievement test scores are often used in an
educational system to determine what level of
instruction for which a student is prepared.

• High achievement scores usually indicate a mastery
of grade-level material, and the readiness for
advanced instruction.

• Low achievement scores can indicate the need for
remediation or repeating a course grade.

https://en.wikipedia.org/wiki/Test_score


Characteristics of a good test

• Test preparation activities which promote quality, long-term learning
are appropriate, even essential. Good test-taking skills and
appropriate content learning can reduce the likelihood that
extraneous factors will influence students’ test scores. The various
characteristics of a good test are:

• It can be tried out and selected on the basis of its difficulty level and
discriminating power.

• Directly related to the educational objectives.
• It should possess description of measure behaviour in realistic and

practical terms.
• Contains a sufficient number of test items for each measured

behaviour; concerned with important and useful matter;
comprehensive, brief, precise and clear.



•It should be divided into different knowledge and skills
according to behaviour to be measured.
•Standardized the items and made instructions clear so that
different users can utilize it.
•Rules and norms have to be developed so that various age
groups can use at various levels.
•It provides equivalent and comparable forms of the test.
•A test manual has to be prepared, which can act as a guide for
administering and scoring.



BLUE PRINT

A blueprint is a guide for making something — it's a 
design or pattern that can be followed. Want to build the 
best tree house ever? Draw up a blueprint and follow the 
design carefully. 
The literal meaning of a blueprint is a paper — which is 
blue — with plans for a building printed on it.



Maths
Achievement Test 



TABLE-1: SHOWING THE WEIGHTAGE ALOTTED TO THE OBJECTIVES

OBJECTIVES MARKS ALLOTED PERCENTAGE

Knowledge 05 12.5%

Understanding 17 42.5%

Application 16 40%

Skills 02 5%

TOTAL 40 100%

S.NO TOPIC
S

MARKS 
ALLOTED

PERCENTAGE

1. Fraction 13 32.5%

2. Playing
with 
numbers

14 35%

3. mensura
tion

13 32.5%

TOTAL 40 100%

S.NO FORMS OF 
QUESTIONS

MARKS 
ALLOTED

PERCENTAGE

1. Very short 
answers(VSA)

7 17.5%

2. Short 
answers(SA)

8 45%

3. Long/ essay
type answers

15 37.5%

TOTAL 40 100%

TABLE-2: WEIGHTAGE GIVEN TO 
THE TOPIC

TABLE-3: WEIGHTAGE GIVEN TO 
DIFFERENT FORMS OF QUESTIONS



FORMS OF
QUES       

TOPIC 

KNOWLEDGE
LEVEL

UNDERSTANDING
LEVEL

APPLICATION
LEVEL

SKILLS TOTAL

V.S.A S.A L.A V.S.A S.A L.A V.S.A S.A L.A

INTEGERS 3(1) 5(1) 3(1) 2(2) 13(5)

FRACTIONS 1(1) 1(1) 3(1) 1(1) 3(1) 5(1) 14(6)

AREA AND 
PERIMETER

1(1) 3(1) 5(1) 1(1) 3(1) 13(5)

TOTAL 5(3) 17(5) 16(6) 2(2) 40(16)

BLUEPRINT
Class: VI
Subject: Mathematics

Time: 80 min
M.M: 40

VSA: Very Short Answers 
Questions
SA: Short Answer Questions
LA: Long Answer Questions

Number in bracket shows number of 
questions.
Number outside the bracket shows marks 
given to each questions.



Subject- Mathematics
Class-VI

Time: 80 minutes M.M: 40
General Instructions

Section ‘A’ contains 5 very short answer questions,1 marks each
Section ‘B’ contains 5 short answer questions, 2 marks each
Section ‘C’ contains 4 long answer questions, 3 marks each

Section-A
Q1. Write the next 3 natural numbers after 10999.
Q2. Find the perimeter of a square with a side of 25 cm.
Q3. Identify the successor of 2440701
Q4. Find the sum by suitable rearrangement of 837+208+363
Q5. Measure the length and the breadth of rectangle 
Q6. Write 3 equivalent fraction of 3/5
Q7. Find the fraction having denominator 16 equivalent to 3/8

Section-B
Q8. Find the product using suitable properties
a) 738 X 103 b) 854 X 102 c) 258 X 1008



Q9. Justify through examples. If the product of two whole number is 1 , can we say 
that one of both of them will be 1?

Q10. Find the perimeter of the table top measures 2m 25 cm by 1m 50cm.
Q11. Illustrate, A piece of string is 30 cm long. What will be the length of each side if 

the string is used to form.
a) A square b) an equilateral triangle c) a regular hexagon
Q12. Find the equivalent fraction of 3/5 having:-
a) Denominator 20 b) numerator 9 c) denominator 30
Q13. Replace the following fraction to simplest form :-
a) 48/60 b) 150/60 c) 84/98

Section-C
Q14. Ila read 25 pages of a book containing 100 pages, lalita read 2/5 of the same 

book. Illustrate who read less.
Q15. Find the common factors of :-
a) 20 & 28 b) 15 & 25 c) 35 & 50 d) 56& 120 e) 5 & 15
Q16. Explain the number of tiles whose length and breadth are 12cm and 5cm resp. 

will be needed to fit in a rectangular region whose length and breadth are resp:-
a) 100cm & 144cm b) 70cm & 36cm



MARKING SCHEME
S.N
o

ANSWERS MARKS

1 11000,11001,11002 1
2 4X25=100cm 1
3 2440702 1
4 1408 1
5 Length=4cm,breadth=2cm 1
6 6/10, 9/15, 12/20 1
7 1x10 + 4x1/100 + 9x1/1000 1
8 a) 76014

b) 87108
c) 260064

3

9 1x1=1
1x6=6

3

10 Perimeter=7.5m 3



S.No ANSWERS MARKS

11 a) side= 7.5cm
b) Side=10cm
c) Side=5cm

3

12 a) 12
b) 15
c) 18

3

13 a) 4/5
b) 5/2
c) 6/7

3

14 Ila has read less number of pages 5

15 a) 1,2,4
b) 1,5
c) 1,5
d) 1,2,4,8
e) 1,5

5

16 a) 240
b) 42

5



SCORE SHEET
Q. No. No. OF students attempted No. of students attempted 

question correct
No. of students attempted 
question incorrect

1 40 38 2

2 40 33 7

3 40 36 4

4 40 33 7

5 40 31 9

6 40 29 11

7 38 28 12

8 36 28 12

9 40 30 10

10 40 37 3

11 40 35 5

12 35 28 12

13 40 33 7

14 40 32 8

15 40 27 13

16 40 36 4



INTERPRETATION

• Students find section A easier
• Question related to the topic Fractions are not 

clear to the some students
• Area and perimeter topic is clear to most of 

the students it means teacher hs taught 
accurately in the class



SUGGESTIONS

• Uncleared topics should be revised in the class 
in free period

• Some remedial classes should be given to 
some students 

• Students scoring good marks above average 
should be appreciated.



BACKWARD	STUDENTS	(Slow	Learners)	:	
CAUSES	AND	REMEDIES	

	

BACKWARD	STUDENTS	
There	may	be	two	types	of	backwardness:	

1. General	backwardness,	and	
2. Particular	backwardness.	
GENERAL	BACKWARDNESS	
This	means	all-round	backwardness.	It	is	almost	inherited	and	is	due	to	a	
low	I.Q.	which	may	be	between	50-70.	We	can	at	the	most	raise	it	by	7	or	
8	points.	The	removal	of	this	backwardness	is	a	joint	responsibility	of	all	
the	teachers	in	the	school.	Of	course,	the	mathematics	teacher	will	be	
required	to	pay	special	attention	in	the	case	of	his	subject.	If	the	case	of	
the	child	is	a	hopeless	one,	it	should	be	guided	sympathetically	to	take	to	
some	manual	type	of	vocation.	

	



PARTICULAR	BACKWARDNESS	
This	is	the	case,	which	is	backward	in	mathematics	but	fairly	intelligent	
in	other	subjects.	The	child	is	otherwise	intelligent,	but	is	weak	in	
mathematics.	Removal	of	particular	backwardness	is	easier	than	
removal	of	general	backwardness,	because	the	former	is	a	hopeful	case.	
His	being	intelligent	in	other	subjects,	is	a	hopeful	sign.	His	achievement	
in	other	subjects	is	a	source	of	confidence	and	inspiration	for	him.	This	
backwardness	is	the	sole	concern	of	the	mathematics	teacher.	Acute	
cases	may	have	to	be	treated	in	separate	classes,	whereas	border	cases	
may	be	tackled	in	the	classroom	itself.	

Before	adopting	any	means	to	remove	the	backwardness,	the	teacher	
must	be	clear	about	its	causes	which	may	be	many.	

CAUSES	AND	REMEDIES	
1. Physical	causes:	There	may	be	some	physical	cause,	such	as	poor	eye-
sight,	defect	in	the	hearing	organ,	stomach	trouble,	headache	or	any	
other	physical	ailment,	which	does	not	allow	the	child	to	concentrate	on	
his	studies.	Mathematics	needs	special	concentration.	The	remedy	of	
almost	all	these	causes	lies	with	the	doctor	or	physician,	but	some	sort	of	
physical	exercise	may	also	help	the	child.	The	teacher	has	to	refer	the	
child	to	the	school	doctor,	some	other	medical	expert	or	the	school	PTI	
according	to	the	nature	of	the	case.	He	has	to	try	to	make	available	all	the	
possible	remedies.	If	it	is	a	case	of	serious	physical	deficiency,	the	
teacher	should	try	to	persuade	the	parents	to	get	their	ward	admitted	to	
a	special	institution	for	the	physically	handicapped	children	of	that	type.	

2. Mental	causes:	The	backwardness	may	be	due	to	some	mental	causes.	
These	causes	may	be	inborn	and/or	environmental.	The	child	may	have	
low	I.Q.,	some	mental	ailment,	mental	dissatisfaction,	domestic	problem,	
mental	conflict,	sense	of	insecurity,	inferiority	complex,	lack	of	interest	
in	mathematics	or	a	dominant	interest	in	something	else.	A	case	of	
simple	mental	problem	can	be	tackled	with	some	chances	of	success	by	
the	teacher.	But	complicated	cases	will	have	to	be	passed	on	to	a	
psychologist	or	a	psychoanalyst	for	thorough	diagnosis	and	treatment.	
An	attitude	of	love	and	sympathy	and	preparedness	to	help	the	children	
on	the	part	of	the	teacher	will	always	be	helpful	in	the	treatment	of	such	
cases.	

3. Distaste	for	the	subject:	A	distaste	for	the	subject	may	be	another	
cause.	This	distaste	may	either	be	natural	or	acquired.	If	it	is	inborn,	the	
teacher’s	efforts	may	go	waste.	But	if	it	is	an	acquired	one,	it	may	be	



mostly	the	teacher’s	fault.	If	he	fails	to	develop	a	feeling	of	attachment	
between	the	child	and	himself,	the	only	outcome	is	the	child’s	distaste	
for	the	subject.	Heaviness	of	the	syllabus,	toughness	of	the	subject	and	
difficulty	of	its	problems	tend	to	produce	this	distaste.	A	genuine	taste	
for	the	subject	will	be	developed	through	the	teacher’s	patience	and	
persistence.	He	should	never	be	in	a	hurry	to	pronounce	case	as	hopeless	
and	backward.	He	should	never	allow	the	idea	‘once	backward	always	
backward’	to	enter	his	mind.	

4. Doubts	about	fundamentals:	Sometimes	the	child	develops	some	
doubts	about	the	fundamentals	of	the	subject,	and	these	doubts	hinder	
his	progress	throughout.	The	teacher	should	be	very	careful	while	
teaching	these	fundamentals.	He	should	not	hesitate	to	explain	them	
over	and	over	again	if	required.	Only	a	clear	understanding	of	these	
fundamentals	can	build	a	sound	foundation	for	mathematical	learning.	

5. Wrong	influence	of	home:	Influence	of	the	home	may	also	create	
distaste	and	backwardness.	Some	parents	unintentionally	provide	
negative	suggestions	to	their	children.	Some	of	them	are	in	the	habit	of	
saying	that	they	never	liked	mathematics	or	they	never	wanted	to	study	
it,	or	were	never	able	to	pass	in	it	or	that	failure	in	mathematics	has	been	
a	tradition	of	their	family.	Even	the	educated	parents	commit	such	
mistakes.	These	pronouncements	are	likely	to	have	an	adverse	effect	on	
the	child’s	attainment	in	the	subject.	Parents	must	be	made	conscious	if	
this	adverse	effect	and	their	duty	in	this	manner.	

6. Teacher’s	behavior:	The	teacher’s	unbalanced	behavior	may	also	be	
one	of	the	causes.	If	he	is	very	lenient,	some	of	the	clever	and	
mischievous	students	may	get	undue	advantage	of	it	and	may	become	
backward	due	to	continuous	inattention	and	non-seriousness.	If	he	is	
very	strict	and	gives	heavy	punishment	unsparingly,	some	of	the	feeble-
minded	students	may	get	disheartened	and	discouraged.	They	may	start	
disliking	the	teacher	and	consequently	the	subject.	The	teacher	should	
never	forget	that	his	behavior	is	very	important.	

7. Mid	session	changes:	The	change	of	school	or	even	the	change	of	
teacher	may	not	suit	some	of	the	students.	Whenever	the	change	of	
school	is	unavoidable,	the	parents	and	the	teachers	have	to	remain	on	
guard	till	the	child’s	complete	adjustment	with	the	change.	Changing	the	
teacher	in	the	middle	of	a	session	should	be	avoided	as	far	as	possible.	

8. Teacher’s	reputation:	The	subject	teacher’s	bad	reputation	in	the	
school	and	neighbourhood	may	also	affect	some	of	the	students	
adversely.	The	teacher	must	earn	respect	and	reputation.	He	should	be	a	
source	of	inspiration	for	his	students	in	every	respect.	He	should	
carefully	maintain	his	scholarship	and	character.	



9. Apathy	towards	method:	A	part	of	the	students’	apathy	towards	the	
teacher’s	most	favourite	method	of	teaching	may	result	in	their	
backwardness.	The	teacher	should	not	always	stick	to	the	same	method.	
Students	like	‘newness	and	novelty’.	The	teacher	should	always	be	
prepared	to	adjust	his	method	to	the	learner’s	likes.	He	may	have	to	
devote	extra	time	and	attention	to	the	student	who	is	lagging	behind.	
Slow	learner	deserves	the	teacher’s	individual	attention	and	help.	The	
teacher	should	so	conduct	himself	that	the	slow	learners	never	feel	that	
they	are	being	disowned	or	being	left	behind.	

10. Lack	of	practice:	Of	these	students,	some	may	need	more	practice	
and	drill	than	others.	The	teacher	should	not	overlook	their	need.	The	
intelligent	one	may	pick	up	an	idea	after	solving	only	one	problem,	
whereas	the	slow	learner	may	need	solving	two	or	three	problems	to	
grasp	it.	The	teacher	has	to	adopt	a	via-media.	

11. Neglect	of	home	work:	When	the	child	does	not	get	sufficient	
time	at	his	home	for	home	work,	he	is	likely	to	lag	behind.	Regularity	in	
home	work	should	be	ensured.	The	parents	should	give	full	cooperation	
to	the	teacher	in	this	regard.	

12. Irregular	attendance:	If	the	child	remains	unavoidably	irregular	
or	absent	for	a	long	time,	there	are	chances	of	his	falling	a	prey	to	
backwardness.	The	facility	of	extra-coaching	for	sometime	should	be	
provided	to	such	students	so	that	they	can	fill	up	their	gaps	and	catch	up	
with	other	class-fellows.	Such	temporarily	backward	students	should	not	
be	left	to	themselves.	The	provision	of	extra-classes	made	in	most	of	the	
schools	near	the	examination,	enables	many	backward	students	to	get	
through.	

13. Defective	handwriting:	Defective	hand	at	writing	and	geometrical	
constructions	may	be	the	cause	of	unsatisfactory	performance	in	certain	
cases.	Their	weakness	does	not	therefore	pertain	to	mathematics.	The	
cooperation	of	language	teacher	may	be	sought	in	their	case.	The	teacher	
should	make	it	a	point	to	insist	on	neatness	of	hand	and	construction	in	
such	cases.	

14. Examination	system:	Faulty	examination	system	may	also	cause	
non-seriousness	and	backwardness	among	some	students.	If	passing	in	
mathematics	is	not	compulsory	at	the	time	of	passing	the	final	
examination,	some	students	may	ignore	this	subject.	Therefore	it	should	
be	treated	as	a	compulsory	in	this	respect.	
 



CC1Continuous and Comprehensive Evaluation

Chapter 1Chapter 1
Continuous and Comprehensive EvaluationEducation aims at making children capable of becoming responsible, productive and useful members of society. Knowledge skills and attitudes are built through learning experiences and opportunities created for learners in school. It is in the classroom that learners can analyse and evaluate their experiences, learn to doubt, to question to investigate and to think independently.Globalisation in every sphere of society have important implications for education. We are witnessing the increasing commercialisation of education. We need to be vigilant about the pressures to commodify schools and the application of market-related concepts to schools and school quality. The increasingly competitive environment into which schools are being drawn and the aspirations of parents place a tremendous burden of stress and anxiety on children, including the very young to the detriment of their personal growth and development, and thus hamper the joy of learning.The aims of education simultaneously reflect the current needs and aspirations of a society as well as its lasting values and the immediate concerns of a community as well as broad human ideals. At any given time and place they can be called the contemporary and contextual articulations of broad and lasting human aspirations and values.An understanding of learners, educational aims, the nature of knowledge, and the nature of the school as a social space can help us arrive at principles to guide classroom practices. Conceptual development is thus a continuous process of deepening and enriching connections and acquiring new layers of meaning. Alongside is the development of theories that children have about the natural and social worlds, including themselves in relation to others, which provide them with explanations for why things are the way they are, the relationships between causes and effects, and the bases for decisions and acting. Attitudes, emotions and values are thus an integral part of cognitive development, and are linked to the development of language, mental representations, concepts and reasoning.As children's metacognitive capabilities develop, they become more aware of their own beliefs and capable of regulating their own learning.

'We're drowning in information and starving for knowledge'-Rutherford D. Rogers
CBSE



Characteristics of learning:••
•
•
•
•
•

 All children are naturally motivated to learn and are capable of learning. Making meaning and developing the capacity for abstract thinking, reflection and work are the most important aspects of learning. Children learn in a variety of ways-through experience, making and doing things, experimentation, reading, discussion, asking, listening, thinking and reflecting, and expressing oneself in speech, movement or writing-both individually and with others. They require opportunities of all these kinds in the course of their development. Teaching something before the child is cognitively ready takes away from real learning. Children may 
'remember' many facts but they may not understand them or be able to relate them to the world around them. Learning takes place both within school and outside school. Learning is enriched if the two arenas interact with each other. Art and work provide opportunities for holistic learning that is rich in tacit and aesthetic components. Such experiences are essential to be learnt through direct experience, and integrated into life. Learning must be paced so that it allows learners to engage with concepts and deepen understanding, rather than remembering only to forget after examinations. At the same time learning must provide variety and challenge, and be interesting and engaging. Boredom is a sign that the task may have become mechanically repetitive for the child and of little cognitive value. Learning can take place with or without mediation. In the case of the latter, the social context and interactions, especially with those who are capable, provide avenues for learners to work at cognitive levels above their own.Examinations are an indispensable part of the educational process as some form of assessment is necessary to determine the effectiveness of teaching learning processes and their internalization by learners. Various Commissions and Committees have felt the need for examination reforms.  The 

 have all made recommendations regarding reducing emphasis on external examination and encouraging internal assessment through Continuous and Comprehensive Evaluation.This aspect has been strongly taken care of in the National Policy on Education- 1986 which states that 
“Continuous and Comprehensive Evaluation that incorporates both scholastic and non-scholastic aspects of evaluation, 
spread over the total span of instructional time” {8.24 (iii)}.

Hunter Commission (1882), 
Calcutta University Commission or Sadler Commission (1917-1919), Hartog Committee Report (1929), the 
Report of Central Advisory Board / Sargeant Plan (1944), Secondary Education Commission / Mudaliar 
Commission (1952-53)CC 2Continuous and Comprehensive Evaluation



Report on the Committee for Review of NPE-1986-recommendation brought out by Government of India in 1991 lays down norms for “continuous comprehensive internal evaluation and suggests safeguards against abuse of this 
evaluation system”{268(iv)}. Report on the  brought out by MHRD, Govt. of India in January, 1992 has also referred to the provisions of NPE with regard to evaluation process and examination reforms and also suggested 
'continuous and comprehensive internal evaluation of the scholastic and non-scholastic achievement of the 
students' (16.8).The need for Continuous and Comprehensive School-based Evaluation has been reiterated over the last few decades. The  observed, 'On the completion of the course, at the end of the lower or 
higher secondary stage, the student should receive a certificate from the school also giving the record of his internal 
assessment as contained in his cumulative record. This certificate may be attached to that given by the Board in connection 
with the external examination…' (9.81). It further adds, 'This internal assessment or evaluation conducted by the schools 
is of greater significance and should be given increasing importance. It should be comprehensive, evaluating all those 
aspects of students' growth that are measured by the external examination and also those personality traits, interests and 
attitudes which cannot be assessed by it.'  (9.84).The Report of the Task Force on the  observed: In our 
scheme of things, it is the School Boards which are expected to play the central role in the academic renovation of the school 
system. In other words, leadership has to come from the Board. Once the Boards get committed to this vital and supplementary system of evaluation and push it vigorously, this innovation will come to be accepted by more and more schools.Remodelling of School Education Boards – a report on the Task Force on the role and the status of  has explained the philosophy of CCE (4.39).   It further states that 'no agency other 
than the Boards should promote CCE and that is why it is sought to be emphasized that the Boards have to play a pioneering 
role in this regard'(4.40).
“Learning without Burden”- a Report of the National Advisory Committee appointed by the Ministry of Human Resource Development, Department of Education, Govt. of India has stated that:
“ Board examination, taken at the end of Class X and XII, have remained rigid, bureaucratic, and essentially 
uneducative…”Accordingly, National Curriculum Framework - 2005 (NCF-05) proposing Examination Reforms stated - 
“Indeed, boards should consider, as a long-term measure, making the Class X examination optional, thus permitting 
students continuing in the same school (and who do not need a board certificate) to take an internal school examination 
instead”.As a sequel to above, the Position Paper on ̀ Examination Reforms' by NCERT 2006, says,

CABE Committee on Policy

Kothari Commission report (1966)

Role and status of the Board of Secondary Education (1997)

Boards of 
Secondary Education (1997)  

CC3Continuous and Comprehensive Evaluation



“Indeed, it is our view that the tenth grade exam be made optional forthwith.  Tenth-graders who intend continuing in the 
eleventh grade at the same school and do not need the Board certificate for any immediate purpose, should be free to take a 
school-conducted exam instead of the Board exam.”Evaluation is goal directed, and educational outcomes are judged in terms of goal attainment. Every educational programme should aim for the all round development of the personality of the child. Therefore, the learning experiences provided in the school should contribute toward the achievement of the desired goals. A teacher, while deciding about the related learning experience should see both scholastic and co-scholastic outcomes as desirable behavioural outcomes of that programme.The scope of evaluation in schools extends to almost all the areas of learners' personality development. It should include both scholastic and co-scholastic areas, i.e. it should be comprehensive in nature. This is in line with the goals of education. Evaluation is continuous and reveals the strengths and weaknesses of learners more frequently, so that the learners have better opportunity to understand and improve themselves. It also provides feedback to the teachers for modifying their teaching strategies. Obviously, the efforts of CBSE to provide a leadership and pioneering role in implementing CCE is a major breakthrough which attempts to elevate the status of the schools as equal partners of the Board in assessing the attainment levels of the learner for public consumption through a separate independent certificate issued by the schools under the directive of the Board. 
A curriculum is what constitutes a total teaching-learning program composed of overall aims, syllabus, materials, methods and assessment. In short it provides a framework of knowledge and capabilities, seen as appropriate to a particular level.  The syllabus provides a statement of purpose, means and standards against which one can check the effectiveness of the program and the progress made by the learners.  Evaluation not only measures the progress and achievement of the learners but also the effectiveness of the teaching materials and methods used for transaction.  Hence evaluation should be viewed as a component of curriculum with the twin purpose of effective delivery and further improvement in the teaching learning process.Understood properly, evaluation or assessment will not be perceived as something administered by the teachers and taken by the learners on the conclusion of a period of learning.  When evaluation is seen as an end of the learning exercise, both the teachers and the learners will tend to keep it outside the teaching-learning process, rendering assessment broadly irrelevant and alien to the curriculum.  Further such a perception associates anxiety and stress with evaluation for learners.  On the contrary, if evaluation is seen as an integral part built into the 
teaching learning process; it will become continuous like both teaching and learning.  When evaluation is subsumed into teaching learning, learners will not perceive tests and examination with fear. CCE will lead to diagnosis, remediation and enhancement of learning.

Place of Evaluation in the Curriculum

CC 4Continuous and Comprehensive Evaluation



CC5

Evaluation results: Fundamental to effective teaching and learning 

What is ̀ Continuous' and ̀ Comprehensive' Evaluation ?

Success in education is determined by the extent to which the learning  objectives are realized. The progress towards attainment of objectives has to be assessed and evaluated for otherwise, we will not know where we are going.One of the main purposes of evaluation at the school stage is to help the learner's improve their achievement in scholastic areas  and to develop Life Skills and attitudes with reference to the larger context and canvas of life.Further, in NPE (1986) it has been emphasized that at the school level the evaluation should be formative or developmental in nature because at this stage child is in the formative stage of learning and thus the emphasis should be on improvement of learning.
Continuous and Comprehensive Evaluation (CCE) refers to a system of school-based evaluation of 

students that covers all aspects of students development.It is a developmental process of assessment which emphasizes on two fold objectives. These objectives are continuity in evaluation and assessment of broad based learning and behaviourial outcomes on the other.In this scheme the term `continuous' is meant to emphasise that evaluation of identified aspects of students 
`growth and development' is a continuous process rather than an event, built into the total teaching-learning process and spread over the entire span of academic session.  It means regularity of assessment, frequency of unit 
testing, diagnosis of learning gaps, use of corrective measures, retesting and  for their self evaluation.The second term `comprehensive' means that the scheme attempts to cover both the scholastic and the co-scholastic aspects of students' growth and development. Since abilities, attitudes and aptitudes can manifest 
themselves in forms other then the written word, the term refers to application of variety of tools and techniques 
(both testing and non-testing) and aims at assessing a learner's development in areas of learning like :KnowledgeUnderstanding/ComprehensionApplyingAnalyzingEvaluatingCreating

feedback of evidence to teachers and 
students

••••••
The scheme is thus a curricular initiative, attempting to shift emphasis from testing to holistic learning. It 

aims at creating good citizens possessing sound health, appropriate skills and desirable qualities besides 

academic excellence.  It is hoped that this will equip the learners to meet the challenges of life with 

confidence and success.

Continuous and Comprehensive Evaluation
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The objectives of the Scheme are :To help develop cognitive, psychomotor and affective skills.To lay emphasis on thought process and de-emphasise memorizationTo make evaluation an integral part of teaching-learning processTo use evaluation for improvement of students achievement and teaching – learning strategies on the basis of regular diagnosis followed by remedial instructionTo use evaluation as a quality control devise to maintain desired standard of performanceTo determine social utility, desirability or effectiveness of a programme and take appropriate decisions about the learner, the process of learning and the learning environmentTo make the process of teaching and learning a learner-centered activity.
Since education is concerned with the total all-round development of the child, (physical, socio-emotional, 
intellectual etc) all aspects of the child's development need to be assessed. At the moment we do not assess the whole child,  but only his or her academic achievement in specific areas. We assess learner's basically on examination results, we do not assess effort, performance, attitudes to learning, ability to practically apply what is learned in every day situations, nor do we assess them on how creatively they use techniques or critically evaluate different theories.To make the process more comprehensive in nature, it is important that assessment of the child's learning be done in a whole range of situations and environments both in and out of the classroom. The assessment process also needs to be part of the way of providing information and feedback on the extent to which the school and teachers have been successful in realizing the expected outcomes of education. 

learn and  acquire desired skills related to different subject areas.acquire a  level of achievement in different subject areas in the requisite measuredevelop child's individual skills, interests, attitudes and motivation understand and lead a healthy and a productive life.monitor the changes taking place in child's learning, behaviour and progress over time.respond to different situations and opportunities both in and out of school.

••••
••
•

What should be assessed?

In view of getting a complete picture of the child's learning, assessment should focus on the learner's 

ability to –••••••
Continuous and Comprehensive Evaluation
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apply what is learned in a variety of  environments, circumstances and situationswork independently, collaboratively  and harmoniously.analyze and evaluate. be aware of social and environmental issuesparticipate in social and environmental projects and causes. retain what is learned over a period of time.  Schools of the future will need to develop in their learners the ability to take risks, to be adaptable, to be flexible, to cope with constant change and become lifelong learners. In this context, learners become dynamic leaders with teachers as  enablers.Before looking at how assessment is to be undertaken teachers need to determine objectives for achievement at secondary level. They need to look at what Secondary Education should develop in children not only in cognitive domain but also psychomotor and affective domains.  Along with those attributes mentioned above they need to incorporate different age related indices and behaviours into the assessment criteria and practices. They also need to determine what their expectations are from the learner at the end of the secondary stage, and what kind of profile report is required in relation to different aspects and learning areas, that reflect the child's rapidly changing, personal development.Thus assessment is a useful, desirable and an enabling process. To realize this one needs to keep the following parameters in mind -
assess the learner.use a variety of ways to collect information about the learner's learning and progress in subjects and cross curricular boundaries.collect information continuously and record the same.give importance to each learner's way of responding and learning and time it takes to do so.report on an ongoing continuous basis and be sensitive to every learner's responses.provide feedback that will lead to positive action and help the learner  to do better
label learners as slow, poor, intelligent etc.make comparisons between them.make negative statements.

••••••

The need to:••
••••

In the assessment process, one should be careful NOT to:•••
Continuous and Comprehensive Evaluation
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9.1 INTRODUCTION

Your main role as a teacher is to promote quality learning among the students.
This is possible only when you act as a guide and the students actively participate
in the process of learning. During the teaching-learning process, you have to
locate and identify the areas where the learner commits mistakes. It is the crucial
stage of the teaching-learning process where you have to DIAGNOSE and prepare
instructional material for REMEDIAL TEACHING to ensure the desired quality
of learning.

At this stage the role of a teacher is just like a doctor’s. The doctor takes all the
steps necessary to diagnose the disease by performing different tests and then
prescribes medicines for the particular disease.

In the case of education the process of Diagnostic Testing is the STEP and
REMEDIAL TEACHING is the PRESCRIPTION. Hence diagnostic testing and
remedial teaching are very essential for ensuring effective learning and in improving
the quality of education.

In this unit an attempt is being made to discuss the orgnization of Diagnosic Tests
in Mathematics and undertaking appropriate remedial measures.

9.2 OBJECTIVES

After going through this unit, you should be able to:

l understand the meaning and importance of Diagnostic Testing;

l understand the nature and purpose of Diagnostic Testing;

l follow the steps and stages of Diagnostic Testing in the classroom teaching-
learning process; and

l conduct remedial teaching in mathematics in classroom situations.
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9.3 DIAGNOSTIC TESTING : ITS MEANING AND

IMPORTANCE

In general, after completing a particular unit/topic you conduct a test to assess
the achievements of learners. After evaluation you draw some conclusions and
you find that some of the students have fared very well and a particular group of
students have achieved below your expectations. Now you will have to find out
the causes for this low achievement or slow learning. There would be certain
reasons for this low achievement. Now it is very essential to find out the particular
area where the difficulty lies or the particular concept where the learner commits
errors. To locate and identify the areas of learning difficulties leads to Diagnostic
Testing.

After identifying the areas where the error lies, you have to find out the reasons
due to which the particular child/group of students have not responded well. At
this stage you have to play the role of a doctor. If a patient visits the doctor’s
clinic he suggests different tests relevant to the symptoms observed by him. After
getting reports he is in a position to identify and diagnose the disease and then
prescribe the medicine for it.

Likewise, as a teacher, you have to first identify and locate the area where the
error lies. The process adopted for this purpose in educational situations is known
as Diagnostic Testing. We may say that Diagnostic Testing implies a detailed
study of learning difficulties.

In diagnostic testing the following points must be kept in mind:

i) Who are the pupils who need help?

ii) Where are the errors located ?

iii) Why did the error occur ?

Let us take the following examples to make this point more clear.

Example 1

Suppose you have taught the simple method of subtraction of two-digit numbers
without borrowing and then conducted a test which indicates the solutions as
follows :

Student’s name — Mr. ‘X’

98 77 85 81 97

– 62 – 52 – 35 – 40 – 67

36 25 5 41 3

38 68 96 54 75

– 26 – 61 – 26 – 24 – 25

12 7 7 3 5

After conducting test you are in a position to assess the whole group. This
assessment is followed by an analysis i.e., you have to find out about each individual
the area of difficulty or the concept where the learner commits errors. For example,
Student ‘X’ has solved all the questions of subtraction of two-digit numbers without
borrowing correctly except for the subtraction of one digit from another one-digit
number. You find that his answers are 5 – 5 = 5, 7 – 7 = 7, 6 – 6 = 6, 4 – 4 = 4 etc.
You are in a position to diagnose the particular concept which Mr. ‘X’ could not
understand. This is known as Diagnostic Testing.
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While performing a Diagnostic Test you have the specific aim to analyze the
exact nature of the progress made by the learner in a particular topic/unit and to
know the particular area of weakness/error which requires a series of carefully
graded tests. The main aim of Diagnostic Testing is to analyze not to assess. It
will be more clear in the following example.

Example 2

Student’s name – Mr. John

370 590 860 870
– 210 – 230 – 330 – 353

160 360 530 52

67 39 28 75 88
– 43 – 20 – 15 – 40 – 45

24 1 13 3 43

347 182 883 578
– 101 – 90 – 570 – 200

2 6 9 31 37

513 654 845
– 206 – 352 – 203

307 02 6 2

Careless slip

260 280 370
– 109 – 140 – 143

1 240 23

Skill analysis of subtraction performance

You have conducted a test in the classroom to assess subraction skill. After this
assessment you have to find out how many students have not acquired this skill
and who they are. For that particular group you will have to prepare a list to find
the concept which is not clear to the learner or the particular step where the
learner makes mistakes. For instance, in John’s case you have found that he
makes a mistake when the question involves subtraction of zero from a number
or of a number from zero through borrowing from the next digit. John knows how
to subtract zero from zero. You can conclude from this analysis that John makes
a mistake only when the concepts of zero and a number come together in
subtraction. This is identification of the area of learning difficulties, and the process
involved in identifying and testing the problem is called Diagnostic Testing.

Check Your Progress

Notes: a) Write your answers in the space given below.

b) Compare your answers with the one given at the end of this unit.

1. Fill in the blanks using the words: 1) detailed, 2) errors, 3) assess,
4) located, 5) identify, 6) analysis.

i) The aim of class test is to ...................... the performance of pupils.

ii) Diagnostic Test implies .......................study of learning difficulties.
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iii) In the Diagnostic Testing process the problem is................through

due .................................................................................................

iv) Diagnostic Testing means to ............................... the problem areas.

v) In Diagnostic Testing we try to find the area where .............. occur.

9.4 NATURE AND PURPOSE OF DIAGNOSTIC
TESTING

If we consider arithmetical attainments from both a qualitative and quantitative
standpoints, we can distinguish four main points (i) accuracy (ii) speed of writing
(iii) methods of work and (iv) extent of the arithmetic process mastered.

It is obvious that you will try to find the feedback through the medium of class
work or through weekly or monthly tests which indicate pupils’ ability in each of
the four aforesaid directions. But it is not enough for teaching purposes particularly
with those pupils/learners who are slow learners. With this group of learners you
are required to have a more analytical estimate of their achievements. Let us
take the following example :

Example 3

After teaching basic operations (addition, subtraction, multiplication and division)
to a group  of students, you conduct a test of say 10 items and the results are
summarized as below :

Items Errors

1 2

2 1

3 3

4 2

5 3

6 10

7 8

8 9

9 32

10 32

From the above data it is possible to analyze the test items. It is clear that items
9 and 10 have been missed by most of the students. At this stage you have to
rethink to make some modifications in items 9 and 10. This is the stage where
you have identified and located the problem and hence diagnosed the area of
error committed by the learners. Similarly, for items 6, 7 and 8, you will rethink
and evolve instructional material to improve the quality of learning.

The above example suggests that Diagnostic Testing is analytical in nature where
the teacher has to look at the performance of pupils in order to examine why they
have not learned or mastered the particular concept or competency. For each
pupil individually one has to pinpoint the specific kind of mistake he makes. This
analysis is based on the date of performacne rather than the general opinion of
the teacher. It may be interpreted in terms of each students, a group of students,
each concept/competency and for each of the questions.
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Why should the teacher undertake this kind of probe into the performance of
pupils? The obvious response is that he/she wants to ensure the quality of learning
(at the level of mastery) and is curious to know what specific action should be
taken to obtain the desired results. Thus the main purpose of Diagnostic Testing
is to spot the learning difficulties of pupils with a view to developing corrective
measures, termed as remedial teaching.

9.5 STEPS AND STAGES IN DIAGNOSTIC TESTING

The essential steps in educational diagnosis are:

i) Identifying the students who are having trouble or need help.

ii) Locating the errors or learning difficulties.

iii) Discovering the causal factors of slow learning.

i) Identifying the students who are having trouble or need help

First, one must know the learners who require help. For this you can administer a
general achievement test based on the topics already taught. After evaluation
you will be in a position to make lists of students who are below average, average
or above average. Next, one has to locate the area where the error occurs in
order to have a deeper insight into the pupils’ difficulties.

ii) Locating the errors or learning difficulties

After identifying the students who need help and visualising the necessity of
additional instructional material to improve the quality of learning, your main role
is to find out the area where the learner commits mistakes or which is the area
where learning difficulties lie. For example we examine the pupils’ responses as
follows:

i)
3
4

5
4

8
4

+ = ii)
2
3

5
3

7
3

+ =

iii)
7

12
4

12
11
12

+ = iv)
4

13
5

13
9

13
+ =

v)
3
4

5
4

8
4

+ = vi) 1+ =
3
4

4
4

vii) 3+ =
5
7

8
7

viii) 5+ =
1
7

6
7

ix)
1
2

+ =
1
3

2
5

x)
3
7

+ =
4
5

7
12

From the above example you would realize that the learner has the knowledge of
adding fractions having the same denominator but the concept of addition of
fractions having different demoninators is not clear to him even through it was
taught in the classroom. Thus you have located the area where the learning difficulty
lies.

iii) Discovering the causal factors of slow learning

In some cases of learning difficulties, the causal factors are relatively simple. A
student may be inattentive during teaching-learning or may be committing errors
due to insufficient practice or irregular attendance.
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Sometimes the cause is ill-health or faulty work habits etc. It has also been observed
sometimes that the basic cause of low achievement is a feeling of helplessness or
the complexity of the subject-matter which perhaps is much above the level of
their comprehension.

Sequential presentation in Fig. 9.1 shows how diagnosis leads to improved quality
of learning.

Teaching-learning Evaluation Unsatisfactory
performance of pupils
      

Identify   Administer a      A case for
students General Achievement diagnosis
who need Test or use the data
help of previous testing
   
Locate  Identify  Provide   Improved
the area causal remedial quality
of difficulty factors measures of learning

Fig. 9.1

This is how quality can be improved through diagnosis.

9.6 REMEDIAL TEACHING

While diagnosis is the process of investigating the learners’ difficulties and the
reasons for this, its follow up leads to actions that may help children make up
their deficiencies. This step is generally termed Remedial Teaching. So you have
to be skilled in preparing or arranging for such materials which may be used to
undertake corrective instruction and thus enhancing the quality of learning.

Selection of Materials

The following points should be kept in mind while selecting appropriate instructional
material:

i) The corrective material should be designed to correct the students’ individual
difficulties.

ii) You have to analyze the work of slow learners by means of observation,
interview and Diagnostic Testing. A careful consideration of the three may
help decide what kind of corrective material is to be designed and whether
material will be adequate to correct the specific difficulties of learners.

iii) The corrective material should be graded, self-directive and should permit
students to work independently. Written directions, which accompany the
material, should be easily readable and comprehensible by the students.

iv) The corrective material must permit individuals to progress according to their
pace.

v) The material should encourage systematic recording of evidence of pupils’
progress.

Some examples

The following examples will illustrate the points discussed above.
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Example 1

For preparing the material for remedial teaching, let us explain the example
discussed in 9.5 above. In this you had diagnosed that the learners had not
understood the concept of adding fractions of the following type:

1
3
4

,  2
5
7

,  3
6
7

,  etc.+ + +

On the other hand, they had attained mastery over adding fractions of the type

1
2

3
2

;  
3
2

5
2

;  
3
4

5
4

;  
4
5

7
5

+ + + + ; etc.

Accordingly now you will have to prepare material where the learner should
have plenty of opportunity to exercise on equalization of denominators in the
given fractions.

i) 1
4

1

1

3

4

1 4

1 4

3

4

4

4

3

4

4 3

4

7

4
+

3
= + =

×
×

+ = + =
+

=

ii) 2
5
7

2
1

5
7

2 7
1 7

5
7

14
7

5
7

14 5
7

19
7

+ = + =
×
×

+ = + =
+

=

iii) 3
6
7

3
1

6
7

3 7
1 7

6
7

21
7

6
7

21 6
7

27
7

+ = + =
×
×

+ = + =
+

=

iv)
1
2

1
3

1 3
2 3

1 2
3 2

3
6

2
6

3 2
6

5
6

+ =
×
×

+
×
×

= + =
+

=

v)
3
7

4
5

3 5
7 5

4 7
5 7

15
35

28
35

15 28
35

43
35

+ =
×
×

+
×
×

= + =
+

=

Enough practice should be provided to pupils on similar questions until they attain
mastery. While selecting and implementing the instructional material the most
important thing is the individual need of the student in a particular area. You have
to give differential treatment. Different methodologies have to be adopted for
different kinds of students. Other modes of interaction such as learner-learner
interaction and learner-material interaction may also be utilized, besides the
traditional teacher-learner interaction, using appropriate instructional material.

Example 2

The following are graded exercises to diagnose the difficulty in addition.

1st step

1 4 1 5 1 2 2 (10 to 18 in one line, 1 to 9
+ 3 + 4 + 6 + 1 7 in the other; no carrying)

2nd Step

1 0 1 3 1 2 1 1 (10 to 19 in both lines,
+ 1 5 + 1 6 + 1 4 + 1 0 zero introduced; no carrying)

3rd Step

3 1 6 5 2 3 2 8 (10 to 89 in both lines;
+ 6 6 + 2 2 + 7 3 + 3 0 no carrying)
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4th Step

123 346 482 543 (Hundreds and tens in both
+ 145 + 212 + 305 + 126 lines; no carrying)

5th Step

9 15 6 9 (1 to 9 in one line, 10 to 19 in the other;
+ 19 + 6 + 17 + 17 with carrying)

6th Step

57 58 6 8 (1 to 9 in one line, 10 to 89 in the other;
+ 7 + 6 + 89 + 68 with carrying)

7th Step

87 96 84 50 (Tens in both the lines; carrying in
+ 31 + 63 + 94 + 81 tens place)

8th Step

23 39 14 37 (Tens in both the lines; carrying in
+ 17 + 48 + 79 + 59 units place)

9th Step

401 209 874 635 (Numbers over 100 in one or both lines.
+ 607 + 39 + 83 + 944 carrying in units or tens or hundreds

place)

10th Step

56 38 57 54 (Tens in both the lines; carrying in both
+ 69 + 86 + 59 + 97 units and tens place)

11th Step

74 38 46 86 (Column addition 3 lines
+ 56 + 78 + 37 + 48 number under 100; with carrying)

43 94 96 39

12th Step

897 953 765 925 (Hundreds, tens and units in both lines;
+ 497 + 818 + 488 + 469 carrying in 2 or 3 places)

13th Step

77 94 277 126 (Column addition 4 lines of 2-digit
+ 48 + 83 + 183 + 848 numbers and 3 lines of 3-digit

32 76 149 976 numbers; with carrying)
65 59
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14th Step

28 608 3 951 (Variation in column addition; introducing
+ 103 + 705 + 81 + 382 difficult number combinations)

784 33 19 467
9 219 827 539

94 196

After conducting the above test you will be able to locate all the possible errors
which students could commit while performing the addition. For example one child,
say Neeta, has not learnt to carry. She worked the first sixteen sums correctly but
after that all her efforts were like this:

9 15 6 9
+ 19 + 6 + 17 + 17

57 58 6 7
+ 7 + 6 + 89 + 68

5 14 5 14 8 15 6 15

In the case of a second student, Lata, you find evidence of a persistent error in a
certain combination, e.g.,

96 635 56
+ 63 + 944 + 69

129 1279 122

You may notice that this child finds it difficult to add 9 with 6 or vice-versa. You
have to prepare different remedial teaching material for these two students, namely
Neeta and Lata. In the case of Neeta questions based on carrying will be set in
exercises. In Lata’s case questions based on adding the two numerals 6 and 9 will
be set to remove the errors.

The following example takes into account graded subtraction with a view to
diagnosing pupils’ difficulties in subtraction.

Example 3

1st Step

98 57 84 38 (Tens and units in minuend:
– 3 – 4 – 1 – 8 units in subtrahend; no borrowing)

2nd Step

55 99 78 97 (Tens and units in minuend and
– 23 – 54 – 21 – 81 subtrahend; no borrowing)

3rd Step

346 987 378 496 (Hundreds, tens and units in minuend and
– 215 – 832 – 122 – 261 subtrahend; no borrowing)

1 18 1 11 1 13 1 16
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4th Step

18 19 16 17 (Numbers less than 20. Unit digit in
– 14 – 18 – 10 – 15 subtrahend less than the unit digit in

minuend; tens digit unity in both)

5th Step

71 62 46 84 (Tens in minuend; unity in subtrahend;
– 2 – 4 – 7 – 6 borrowing in units)

6th Step

54 22 58 46 (Tens and units in minuend and
– 39 – 17 – 19 – 27 subtrahend; borrowing in units)

7th Step

331 543 283 786 (Hundreds, tens and units in minuend,
– 18 – 25 – 29 – 58 tens and units in subtrahend;

borrowing in units)

8th Step

316 564 68 387 (Borrowing in units and tens or borrowing
– 27 – 59 – 59 – 279 in units, and ‘0’ result in tens)

9th Step

980 160 80 430 (Introduction of ‘0’ difficulty in units or
– 930 – 68 – 57 – 416 tens)

10th Step

180 250 160 890 (Introduction of examples having zero as
– 71 – 49 – 31 – 889 units in minuend and 1 to 9 as units in

subtrahend)

11th Step

346 629 756 387 (Borrowing in tens place;
– 284 – 473 – 382 – 196 numbers over 100)

12th Step

364 831 8354 8112 (Borrowing in hundreds, tens and
– 295 – 276 – 5676 – 6798 units places)
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13th Step

800 607 700 906 (Advanced ‘0’ difficulty and borrowing)
– 695 – 298 – 192 – 109

14th Step

891 904 705 60 67 (Advanced ‘0’ difficulty and borrowing)
– 207 – 206 – 109 – 59 70

After conducting this test you would be able to know the nature of errors committed
by individual students in subtraction. For example: In the case of Student ‘X’, the
following pattern of errors and learning difficulties were observed:

In 1st Step; One error

38
– 8

3

2nd and 3rd Steps, No errors.

4th Step : Four errors

18 19 16 17
– 14 – 18 – 10 – 15

4 1 6 2

5th, 6th, 7th & 8th Steps; No errors

9th Step; Two errors

80 430
– 57 – 416

3 2

10th Step; Four errors

180 250 160 890
– 71 – 49 – 31 – 889

11 21 13 1

11th & 12th Steps; No errors

13th Step; Four errors

800 607 700 906
–695 – 298 – 192 – 199

2 4 9 6 8 7

14th Step; Three errors

904 705 69 67
– 206 – 109 – 59 70

7 8 6 6 1
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You have come to know the types of errors committed by ‘X’ in different steps.
Now you will think to prepare material for remedial teaching for different learning
difficulties faced by ‘X’. The diagnosis made on the basis of a graded test provides
a definite direction to remedial teaching. The teaching-learning strategy should of
course, put emphasis on exercises in the relevant area of difficulty until mastery
is achieved. Further testing would be desirable to examine the impact of remedial
teaching.

9.7 LET US SUM UP

In this unit you have learnt about Diagnostic Testing which is the most important
part of the teaching-learning process. It implies a detailed study of learning
difficulties. Its aim is to analyze, not to assess. The nature and purpose of
Diagnostic Testing is to identify the areas of difficulties where the learner commits
errors. The stages of diagnostic testing are:

i) Identifying the students who need help.

ii) Locating the error/learning difficulties.

iii) Discovering the causal factors.

After locating the area where the difficulty lies, as a teacher you will devise
some strategy to remove problems in learning and the causes due to which the
learner has faced the difficulties. The strategy used by you to remove the weakness
of the learner is known as remedial teaching. Diagnostic Testing leads to remedial
teaching in which you have to prepare instructional material for quality learning,
adopting different methodologies as per needs of the individual or a particular
group.

9.8 UNIT-END EXERCISES

1. Define Diagnostic Testing.

2. Distinguish between Test and Diagnostic Testing.

3. Explain the nature and purpose of Diagnostic Testing.

4. Prepare a graded test for diagnosing problems in multiplication.

5. What is remedial teaching?

6. Prepare remedial teaching material for enhancing the learning of multiplication
technique.

9.9 ANSWERS TO CHECK YOUR PROGRESS

1. i) assess

ii) detailed

iii) located, analysis

iv) identify

v) errors



Diagnostic Test: Concept, 
Construction and Barriers 
After reading this, you will learn about:- 1. Concept of Diagnostic 
Test 2. Dimensions of Diagnostic Test 3. Steps 4. Construction 5. 
Materials Used 6. Elements 7. Barriers. 

Concept of Diagnostic Testing: 
The term diagnosis has been borrowed from the medical profession. 
It means identification of disease by means of patient’s symptoms. 
For example, when a patient comes to a doctor, the doctor initially 
puts some questions to the patient to gather some basic 
information’s about the disease and then uses other techniques to 
get more related information to identify the disease and its probable 
cause(s). 

After careful analysis of these data, he prescribes the medicines as 
remedial treatment. Similarly, in the field of education, diagnosis 
has many such implications. Difficulties in learning occur 
frequently at all levels and among pupils of both high and low 
mental ability. 

In order to handle such cases, the teacher also uses similar 
techniques like a doctor to diagnose the relative strengths and 
weaknesses of pupil in the specific area of study, analyse the causes 
for the same and then provides remedial measures as per necessity. 

Since tools and techniques used in mental measurements are not 
that exact, objective and precise like the tools and techniques used 
in sciences, the teachers are cautioned to use the diagnostic data 
with great care for designing remedial programmes. 



But it is used in education to determine the learning difficulties or 
deficiencies of the learner. Diagnostic test is a test used to diagnose 
strength and weakness of the learning in certain areas of study 
whereas diagnostic evaluation is centered on schooling process such 
as the curriculum programme, administration and so on. 

When learning difficulties that are left unresolved by the standard 
corrective prescriptions of formative evaluation and a pupil 
continues to experience failure despite the use of prescribed 
alternative methods of instruction, then a more detailed diagnosis is 
indicated. 

To use a medical analogy, formative testing provides first aid 
treatment for simple learning problems and diagnostic testing 
searches for the underlying causes of those problems that do not 
respond to first aid treatment. 

Thus it is much more comprehensive and detailed and the 
difference lies in the types of question each of them is addressing. 

The following are the salient features of Diagnostic 
Testing: 
(i) The diagnostic test takes up where the formative test leaves off. 

 (ii) A diagnostic test is a means by which an individual profile is 
examined and compared against certain norms or criteria. 

(iii) Diagnostic test focuses on individual’s educational weakness or 
learning deficiency and identify the gaps in pupils. 



(iv) Diagnostic test is more intensive and act as a tool for analysis of 
Learning Difficulties. 

(v) Diagnostic test is more often limited to low ability students. 

 (vi) Diagnostic test is corrective in nature. 

(vii) Diagnostic test pinpoint the specific types of error each pupil is 
making and searches for underlying causes of the problem. 

(viii) Diagnostic test is much more comprehensive. 

(ix) Diagnostic test helps us to identify the trouble spots and 
discovered those areas of students weakness that are unresolved by 
formative test. 

Dimensions of Diagnostic Test: 
 (i) Who can conduct → Teacher/Researcher 

(ii) Where → School/Home/Work places 

(iii) On whom → Learners 

(iv) Purpose → Specific strength and weakness of the learner in a 
particular area. 

(v) Length of time → Flexible in nature 

(vi) Techniques of → Test/observation/interview etc. Assessment 

(vii) Sequence → Logical and step by step 

(vii) Method of → Negotiable/Therapeutic Remediation 



(ix) Support to → Learner/Parents/Teacher 

Steps of Educational Diagnostic Test: 
(i) Identification and classification of pupils having 
Learning Difficulties: 
(a) Constant observation of the pupils. 

(b) Analysis of performance: Avoiding assignments & copying from 
others. 

(c) Informal classroom Unit/Achievement test. 

(d) Tendency of with-drawl and gap in expected and actual 
achievement. 

 (ii) Determining the specific nature of the Learning 
Difficulty or errors: 
(a) Observation. 

(b) Analysis of oral responses. 

(c) Written class work. 

 (d) Analysis of student’s assignments and test performance. 

(e) Analysis of cumulative and anecdotal records. 

(iii) Determining the Factors/Reasons or Causes Causing 
the learning Difficulty (Data Collection): 
(a) Retardation in basic skills. 

(b) Inadequate work study skills. 

(c) Scholastic aptitude factors. 



(d) Physical Mental and Emotional (Personal) Factors). 

(e) Indifferent attitude and environment. 

(f) Improper teaching methods, unsuitable curriculum, complex 
course materials. 

(iv) Remedial measures/treatment to rectify the 
difficulties: 
(a) Providing face to face interaction. 

(b) Providing as may simple examples. 

(c) Giving concrete experiences, use of teaching aids. 

(d) Promoting active involvement of the students. 

(e) Consultation of Doctors/Psychologists/Counselors. 

(f) Developing strong motivation. 

(v) Prevention of Recurrence of the Difficulties: 
(a) Planning for non-recurrence of the errors in the process of 
learning. 

Construction of Diagnostic Test: 
The following are the broad steps involved in the construction of a 
diagnostic test. Diagnostic Test may be Standardized or Teacher 
made and more or less followed the principles of test construction 
i.e., preparation, planning, writing items, assembling the test, 
preparing the scoring key and marking scheme and reviewing the 
test. 



The Unit on which a Diagnostic Test is based should be 
broken into learning points without omitting any of the 
item and various types of items of test is to be prepared in 
a proper sequence: 
1. Analysis of the context minutely i.e., major and minor one. 

2. Forming questions on each minor concept (recall and recognition 
type) in order of difficulty. 

3. Review the test items by the experts/experienced teacher to 
modify or delete test items if necessary. 

4. Administering the test. 

5. Scoring the test and analysis of the results. 

6. Identification of weakness 

7. Identify the causes of weakness (such as defective hearing or 
vision, poor home conditions, unsatisfactory relations with 
classmates or teacher, lack of ability) by the help of interview, 
questionnaires, peer information, family, class teacher, doctor or 
past records. 

8. Suggest remedial programme (No set pattern). 

Motivation, re-teaching, token economy, giving reinforcement, 
correct emotion, changing section, giving living examples, moral 
preaching’s. 

Materials Used in Diagnostic Test: 



Classroom teachers, principals, supervisors and qualified 
diagnosticians use the following resources and materials 
in making educational diagnoses more vibrant: 
1. Test records (Standardized and Teacher made). 

2. Pupils’ written work (themes, compositions, home assignments 
and test papers). 

3. Pupils’ oral work (discussion, speeches and oral reading). 

4. Pupils’ work habits (in class activities, participation, peer 
relationship, independent work, interest, effort etc.). 

5. Physical and health records (school and family records about 
vision, hearing, dental, general). 

6. Guidance and cumulative record data (family) background, 
anecdotal references, school activities). 

7. Interview with pupil (problem or trouble and elimination of 
misconceptions). 

8. Parent conference (pupil problems at home, parent 
interpretation). 

9. Self-guidance (completing assignments, independent work and 
seeking teacher help). 

10. Clinic or laboratory aids (vision tester, audio-meter eye 
photographs, tape recorder etc.). 

Elements of Diagnostic Tests: 



 
Barriers in Diagnostic Tests: 
(i) Attitudinal change. 

(ii) Will Power and patience of the teacher. 

(iii) Time Scheduling . 

(iv) Sequencing of Study. 

(v) Faulty method of data collection and test. 

(vi) Maintaining records impartially. 

(vii) Costs. 
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CHAPTER V 

ENRICHMENT PROGRAMME FOR THE GIFTED 

Gifted students typically find their regular classroom experiences 

dull and less than challenging. Although some rare teachers detect 

the gifted child's spark and do everything they can to fan it to flame, 

the majority of gifted students sit in schools for twelve years expe­

riencing precious little challenge and motivation. This therefore, 

implies that the typical classroom diet is inadequate for the academic­

ally talented child. Gifted children should, therefore, be provided 

with learning activities that challenge them and expand and deepen 

their understanding (Greenlaw and Mcintosh, 1988). 

5:02 MEANING 

The specific defining attributes of the concept of enrichment in 

planning educational programmes have varied across the years and across 

the programmes which have been labelled 'enrichment'. Generally, howe­

ver, the term has been used to designate the process of providing 

activities and/or content areas which are outs ide the range of the 

regular curriculum offered in the schoo 1. Enrichment denotes those 

programmes in which the student remains at grade level but spends 

part of the day or week engaged in activities which are supplemental 

to those offered in his or her classroom. The assumption is made that 

these activities have been especially structured to meet the particu­

lar needs of gifted children(Kauffman and Hallahan, 1981). 

5:03 HORIZONTAL AND VERTICAL ENRICHMENT 

Newland ( 1976) further divided the concept of enrichment into the 

categories of horizontal and vertical enrichment.Horizontal enrich­

ment is used to designate those activities which involve content areas 
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v~hich ma.v not be part of the regular curriculum (or exploration of 

those areas in more depth) but in \Aih ich the leve 1 of sophistication 

usee! in the study and dis cuss ion of those topics remains at about 

the same ~rade level. The assumption underlying horizontal enrichment 

is the need for gifted children to become acquainted with a broad 

spectrum of content areas. 

If however, the level of thinking skills required in carrying out 

the enrichment activities is more sophistica.ted, then the enrichment 

activity is considered vertical enrichment. It is based on the need 

for ~ifted children to develop more complex cognitive processing skills 

such as analysis, evaluation, discrimination and creativity. 

Although the horizontal - vertical distinction is theoretically 

possible and is sometimes incorporated into models for enrichment, 

it has not served a useful purpose in the study of enrichment programmes. 

Proqram~es and models which have been labelled enrichment have genera­

lly been based on a combination of both vertical and horizontal enrich­

ment with their components and their effects being indistinguishable. 

Even a proqramme which has stated explicitly that its objective is 

to develop higher level thinking skills will usually rely on content 

materials outside the regular curriculum in order to achieve these 

qoals. 

5:04 ACADEMIC CURRICULUM FOR THE GIFTED 

While it is true that gifted students do need to know the same 

content as other children and youth and that most will be able to 
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master the skills and content easily and well, it is not true that these 

skills and this content should be covered in the same way for the gifted 

as for other learners. By definition gifted youths require a differen­

tiated curriculum to adequately meet their learning needs. According 

to Greenlaw and Mclntosh(l988) curriculum differentiated for the gifted 

is purposely made, unlike or different from the regular curriculum, 

observers can perceive and imp lementers can express differences between 

it and the regular curriculum. In other words differentiated curriculum 

for the gifted has characteristics that distinguish it from regular 

curriculum for non-gifted students. 

Curriculum for the gifted cannot just be differentiated, it must 

be qualitatively differentiated(Maker, 1982). Based on her own work 

and that of other experts in the field of gifted education, Maker(l982) 

makes several recommendations concerning how basic curriculum can 

be made more appropriate for gifted children and youth. She says modifi­

cations should be made in the areas of content, process, product and 

learning environment. 

At least sixty curriculum mod=ls exist for the gifted. Hm•Jever, 

only three models will be mentioned for the purpose of this study. These 

models emphasize three components that are vital in planning and d=velo­

ping curriculum for gifted students. 

These are: 

1. BloJm•s Cognitive Taxoqomy, which emphasizes higher level thinking. 

2. Williarn•s Teaching Strategies for Thinking and Feeling which ernrha­

size creativity. 
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3. Renzulli's Enrichment Triad, which emphasizes· product.(Greenlaw 

and Mcintosh, 1988). 

BLOOM'S COGNITIVE TAXONOMY 

Bloom's Cognitive Taxonomy is one of the better known and more 

widely used models for creating curriculum for the gifted because 

of its emphasis on developing higher level thinking. It is also rela­

tively simple in design and is easily applicable by teachers with 

a minimum of training in its use (Greenlaw and Mcintosh, 1988). 

As a taxonomy, Bloom's is hierarchical in nature, i.e achievement 

at higher levels in dependent on success at lower levels. The following 

six levels comprise Bloom's Cognitive Taxonomy. 

l. Knowledge: which is the lowest level, consists of remembering what 

has been read, seen or heard, with no transformation of the information 

received. 

2. Comprehension: involves the lowest level of understanding and requires 

that a student be able to restate what has been read, seen, or heard 

in his or her· own words and make use of the information, although 

not relating the information to any other ideas already possessed 

or presented. 

3. Application: involves putting the new information to use in a 

different situation, without being told how to do so. 
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4. Analysis: entails deconstructing the whole into its component parts 

so that the relationship between the parts can be seen. 

5. Synthesis: entails constructing a whole from constituent parts 

- although the new whole or pattern or structure is not the one from 

which the parts were taken. 

6. Evaluation: is the highest level in the taxonomy, and it involves 

making judgements about the value of something, for a particular pur­

pose. Students must either develop their own criteria or be able to 

apply the criteria of others and use various types of evidence in 

order to make these critical, evaluative judgement. 

WILLIAM 1 S TEACHING STRATEGIES FOR THINKING AND FEELING 

William outlines eighteen teaching strategies that lead to creative 

thinking. 

l. Paradox: A seemingly contradictory statement that may nonetheless 

be true. 

2. Attribute: A quality or characteristic belonging to a person or 

thing, a distinctive feature. 

3. Ana logy: A form of log ica 1 inference, based on a correspondence 

in some respect between people or things otherwise dissimilar. 
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4. Discrepancy: A divergence or disagreement, as between facts or 

claims; in-consistency. 

5. Provocative Quest ion: Quest ions intended to excite and stimulate 

students' thinking and exploration of new ideas. 

6. Example of change: A demonstration of how dynamic the world is 

or can be. Making provision for activities that employ modifications 

or substitutions. 

7. Example of habit: Habits are a constant, often unconscious incli­

nation to perform some act, acquired through frequent repetition, 

Activities for this strategy seek to provide examples that encourage 

students to avoid habit - bound thinking. 

8. Organised Random Search: Developing a structure to lead randomly 

to another structure. 

9. Ski 11 s of Search:- The development of methods to search for infor­

mation. This might include trial and error, historical skills or 

experimental skills. 

10. Tolerance for ambiguity: 

Ambiguous situations are open to multiple interpretation. Activities 

for this strategy seek to present open-ended situations for discussion. 
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ll. Intuitive Expression: Intuition is the act of knowing without 

the use of rat ion a l process. Activities for this strategy seek to 

present open-ended situation for discussion. 

12. Adjustment to development: This strategy see~ to enable students 

to develop or change rather than merely adjust to situations. 

13. Study of Creative people and Processes: Activities for this strategy 

encourage students to look at people who are creative and explore 

the processes they utilise. 

14. Evaluation of Situations: Activities for this strategy encourage 

students to engage in prediction from the delineation of actions and 

ideas and to form conclusions based on careful consideration of conse­

quences and inferences. 

15. Creative Reading Skill: Using text as a stimulus for the creation 

of an idea or a product. 

16. Creative listening Skill: Encouraging students to respond to oral 

text in various ways that will allow them to develop ideas and respond 

to questions. 

17. Creative Writing Skill: Encouraging students to express their 

feelings and emotions in clearly written passages. 
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18. Visualization Skill: Activities for this strategy encourage 

students to form a menta 1 image that includes an unusua 1 

or unique prespective (Greenlaw and Mcintosh, 1988). 

RENZULLI'S ENRICHMENT TRIAD MODEL 

The Enrichment Triad Model is one of the very few teaching learning 

models developed specifically for use with gifted children. He develo­

ped the model after extensive experience workin~ with, and evaluating 

programmes for gifted children and youth. According to Greenlaw and 

Mclntosh(l988, p. 227), Renzulli,"sought to design a model that could 

be used as a guide in developing defensible programmes for the gifted 

-programmes that are qualitatively different". His model ties in 

closely with his conclusion about what constitutes giftedness. In 

his three ring conception, giftedness resides at the intersection 

of three clusters of traits (l) Above-Average General Ability, (2) 

Task Commitment, and (3) Creativity. Renzulli believes that the inter­

act ion of these three clusters is necessary for creative productive 

accomplishment. 

Accordingly, Renzulli•s triad model includes three types of enrichment: 

1. Type 1 - General Exploratory Activities: 

The three rna in purposes of Type I enrichment, genera 1 exploratory 

activities are ( 1) exposing students to topics that are not a norma 1 

part of the school•s curriculum, (2) making general enrichment activi­

ties available to all interested students, and (3) inviting highly 

mot iva ted students to find and pursue a later Type II I. Independent 
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Project. Gifted students should understand that they are to explore 

these interest areas purposefully, with a view toward identifying 

ideas for further study. Some students already will have long standing 

interests or hobbies which are well suited for type III projects (pho­

tography, drama, calligraphy and so on). In these cases, Type I acti­

vities serve mainly to expose students to new topic areas. 

Resource centres should be well stocked with books, magazines, 

and other media dealing with a large number of topics. 

Another good exploratory activity is field experiences in which 

gifted and talented students meet dynamic people involved in creative 

and problem - solving endeavour - artists, actors, engineers, museum 

and art gallery curators, T.V show directors, business leaders and 

so on. This type of field trip goes beyond just visiting an art gallery 

or planetarium. The purpose is not to ''look at" but to become involved 

with professionals and their activities. 

The design of Type I exploratory activities will require effort 

and ingeniuty by participating teachers. (Davis and Rimm, 1989). 

Type II Enrichment-Group Training Activities: 

The purpose of Type II Enrichment-Group Training Activities is 

to promote the development of a broad range of thinking and feeling 

processes(Renzulli and Reis, 1985). 

The following are the general and specific skills especially recomm­

ended by Renzulli and Reis. 
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1. Creative thinking, problem solving, critical thinking, decision 

making and affective processes such as appreciating and valuing. 

2. Learning how - to - learn skills, such as listening, observing, 

perceiving, note taking, out lining, interviewing, surveying,analysing 

and organising data and other research skills. 

3. Using advanced - level reference materials including a variety 

of print and non-print references, information retrieval systems and 

other procedures for gaining access to advanced resources. 

4. Writing, oral and visual communication skills that will be directed 

toward maximising the impact of student products upon appropriate 

audiences. (Davis and Rimm, 1989). 

The objective of type II Enrichment is "to develop in the learner 

the processes or operations (the powers of the mind) that enable him/her 

to deal more effectively with content". Renzulli(l977, pp.24-25). 

TYPE III ENRICHMENT - INDIVIDUAL AND SMALL GROUP INVESTIGATION 

OF REAL PROBLEMS: 

With Type III enrichment activities, the gifted young person becomes 

an actual researcher investigating a real problem. Renzulli emphasises 

that students should act as producers of knowledge, not merely consumers 

of information. They should not simply be asked to consult more ency-

clopeadias, text books or other already summarized sources and then 
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write a report. They should use raw data as their main information 

source, from which they draw their own conclusions. 

The student should play an active role or part in formulating the 

problem, designing the research methods and planning the final product. 

The teacher, as the .. guide on the side 11
, helps with clarifying the 

problem, designing the research, and locating materials and equipment, 

and recommends information sources or community experts (Davis and 

Rimm, 1989). 

It is important for students to have audiences for their Type III 

products. Grown-up artists, scientists, and other professionals do 

not keep their work to themselves. Indeed a good part of their motiva­

tion and satisfaction derives from at least a limited amount of publi­

city and public awareness of their accomplishments (Renzulli, Reis, 

and Smith, l98l).Gifted students also are product-oriented; they wish 

to hold up their accomplishments and to inform and perhaps influence 

a particular audience. 

5:05 PERCEPTIONS OF-THE GIFTED WITH REGARD TO EXISTING SCHOOL PROGRAMME 

As mentioned in Chapter III, Section 3:04(vi) an Interview Schedule 

based on the schoo 1 curriculum - subjects and activities offered 

in the school, areas of interest, kinds of activities which the gifted 

children would like to get involved with, methods of teaching etc. 

was conducted on the Very Superior and Superior children. Since the 

number of gifted children in the Very Superior group was small (9 

in number), the Interview Schedule was conducted on all of them. In 

the case of the Superior group with a total of 84 students, the interview 
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was conducted only on 75 p.c of the total number. 

The analysis of responses to some of the items in the Interview 

Schedule in percentage terms is shown in the following table. 

TABLE 5:05 

TABLE SHOWING PERCENTAGE OF RESPONSES OF THE GIFTED CHILDREN WITH 

REGARD TO EXISTING SCHOOL PROGRAMMES: 

Items Very Superior N=9 Superior = 63 

Attitude Highly Satisfied = ll.ll% Highly Satisfied = 22.22% 
Towards Moderately 11 = 11. 11% Moderately 11 = 14.29% 
School Not Satisfied = 77.78% Not Satisfied = 63.49% 
Curriculum 

Working on 
Groups and 88.89% 87.30% 
Projects 

Interest in Arts - nil Arts = 7.94% 
Academic Commerce - N i 1 Commerce - N i 1 
Subjects Maths. = 22.22% Maths. = 30. 16% 

Science = 77.78% Science = 61.90% 

Interest Biology Biology = 4.76% 
in Science Chemistry = ll.ll% Chemistry = 19.04% 
Subjects Maths. = 22.22% Maths. = 30. 16% 

Physics = 66.67% Physics = 46.04% 
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The above table shows the follow1ng: Most of the 1nterviewP.es 
(77% in the Very Superior Group and 63% in the Superior Group) , are not 
satisfied with certain areas of the school curriculum. They would 
be happy' if studies in certain subjects could be expounded, so as 
to create opportunities for them to express their understanding, 
thinking and reasoning etc. 

When asked if they would be interested to work in groups on 

Projects, majority of them, i.e 88% in the Very Superior Group and 
87% in the Superior Group showed their interest to do so if the school 
provided the necessary facilities. 

Regarding their interest in academic subjects, a good majority 
of both groups, (77% and 61% respectively) expressed preference for 
science subjects. Within the Science Subjects as many as 66% of Very 
Superior Group children and 46% of Superior group children indicated 
preference for Physics. 

The other questions covered in the Interview Schedule pertained 
to facilities available in their schools - libraries, laboratories 
etc. Most of them expressed that their schools were not adequately 
equipped. 

It was a 1 so expressed that attending classes which are easily 

managed without the help of a teacher proves to be dull and monotonous 

and therefore, a waste of time. To them, this could be utilized 
in furthering extra programmes and projects. 

When asked the essential need for the presence of the teacher, 
most of them expressed the need especially in guiding and assisting 
them, while they work on projects. 

5:06 ENRICHMENT PROGRAMME 
Basing on the findings of the Interview Schedule, the researcher 

has tried to develop Enrichment Programmes in Physics (depending 
on their choice of interest). The Enrichment Programmes have been 
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developed by drawing ideas contained in the three Models - Bloom's 

Cognitive Taxonomy, William's Teaching strategies for Thinking and 

Feeling and Renzulli's Enrichment Triad Model. The first Enrichment 

Progr.amme relates with the topic "Heat", and the second one with 

"Renewable Sourcesof Energy" 

5:06 A. ENRICHMENT PROGRAMME ON HEAT 

Step I - Knowledge: 

The first step in the Enrichment programme relates with knowledge. 

A good text book (such as Physics by E.White, Physics - George Gammow) 

is given to the students and they are asked to read on the chapter 

of "heat". The teacher than explains to the students certain terms 

like: 

(i) Temperature (ii) Heat (iii) Differences between Heat and Tempe­

rature (iv) Units of Heat (v) Thermal capacity (vi) Water equivalent 

(vii) Specific Heat (viii) Thermal expansion (ix) Co-efficient of 

expansion. 

Step II Comprehehsion: 

This step deals with testing student's comprehension. It could 

be done in the following ways:-

(i) Giving them calculations using specific heat and co-efficient 

of linear expansion. 
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( i i) Asking the students to explain the terms in their own 

words. 

Step III - General Exploratory Activities: 

(l) Present to the students some aspects of Heat such as: 

(i) Loss of heat of a substance under different situation. 

( i i ) Study on Evaporation 

( i i i ) Study on heat as Electro-magnetic Wave 

( i v) Heat and Light 

( v) Heat as a form of energy 

(vi) Expansion of substance under temperature 

(2) Give them time and opportunity to explore a wide variety of 

content - with the one they are interested in, so as to find a topic 

for further indepth study. 

(In between the teacher should ask provocative questions so as to 

excite and stimulate students• thinking and exploration of new ideas). 

Step IV - Group Training Activities: 

In this step the teacher should make use of instructional methods 

and techniques to help the learner to deal more effectively with 

content and which would also help to develop the ~igher levels of 

thinking, William's Teaching Strategies, such as Critical reading 

skill and Creative reading skill should be taught to the gifted chil­

dren. 
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( Critical Reading Skill requires the reader to evaluate the material 

for truth, authority and value and also to be able to lead to conclu­

sions upon which one can act. Creative Reading Skill on the other 

hand involves an even higher level of reading and thinking. It is 

a thinking process in which new ideas are originated, evaluated 

and applied. Creative Reading involves using the printed page as 

a spring board to thinking and action) (Greenlaw and Mcintosh, 

1988). 

To be able to accomplish the above, the reading curriculum 

should have a wide variety of resources where the gifted learners 

will be exposed to different kinds of reference books -Encyclopeadias, 

Dictionaries, Periodicals, Popular Science Series, Supplementary 

Text Books, Journals like Science Reporter, Science Age (2000 AD) 

etc. 

Step V - Individual/Small Group Investigations 

In this step the student becomes an actual investigator of 

a real problem or topic by using appropriate methods of inquiry. 

For example: If students take up 11 Loss of Heat of a Substance 
II 

under different situation, the steps involved would be: 

(i) Students should first of all study the history of development 

of thermometer and thermoflask. 

(ii) They should then design an experiment to compare the 

conductivity of heat of locally available substance such as dry cloth, 
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dry cotton, dry paper, dry bamboo, dry wood, pine - leaves, betel 

nut, peel fibres etc. 

(iii) Check the validity of the designed experiment - allow them 

to exercise their original model of experiment as far as possible 

even at the cost of some amount of anticipation of unreliable findings. 

(iv) Ask them to collect the data very carefully and prepare 

a chart of conductivity of material locally available. 

(v) The next step is to design an experiment to measure the 

heat loss of substances in containers of different materials such 

as copper, aluminium, glass - first without the outer layer to cover 

them- Secondly, by taking different materials for the outer layer 

to cover them (bamboo, cloth etc.) 

(vi) Collect data of temperature versus time with different 

room temperature and graphically represent it. 

(vii) Ask them to design a low cost thermometer. Set guess list 

of performance of the designed thermometer basing on the above finding. 

(For example, water of 60°C w1 11 remain not less than 50°C 

period of ten hours). 

for a 
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( viii) Perform the experiment· with the designed thermof lask to 

see how far the guessed performance is true, (quality test). 

Step VI - Outlets for Creation: 

Present the findings in a newspaper or in a seminar or in childr­

en's magazines which routinely publish children's writings and research 

summaries. If possible Children's Art Shows and Science Fair could 

be arranged to be as outlets for the children's or adolescents's 

products. 

5:06 B. ENRICHMENT PROGRAMME ON ENERGY 

Sub-Topic : Renewable Sources of Energy 

Step-! Knowledge: 

In the first step knowledge or genera 1 awareness of energy 

should be given to the students. This should be based on the concept 

that, "Energy is the capacity of doing work". It could be done in 

the following manner: 

(i) The teacher should inform students about energy with regard 

to: 

(a) Common usage of the term, energy. 

(b) Examples such as - we need energy for our daily 1 ife to 

carry out different types of works:to walk, to run, to lift an object 

etc. Further, an athelete needs more energy than a common man, a 

car needs less energy than a truck to rs~cr same distance. 
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Conclude the information given to the students that MORE THE ENERGY, 

MORE THE CAPACITY TO WORK, LESS THE ENERGY LESS THE CAPACITY TO DO WORK. 

(ii) Allow students to consult books to find out. 

(a) The relation between energy, mass and velocity. 

(b) The potential energy(mgh) and Kinetic energy (~ mv2J 
(c) The different types of energy, their transformation from one 

form to another. 

(d) Unit of energy: Calorie, Watt, Joules, 

(e) Different sources of energy: coal, petroleum, charcoal, electricity 

etc. 

Step II - Comprehension 

Before the pup i 1 s proceed further, comprehension is to be tested. 

The test will not be on how much they can memorize but it will be how far 

their general/qualitative understanding of energy as they learn in step 

I (i) agree with the qualitative mathematical formulae (in step i(ii). 

Some sample/model questions to test pupil's comprehension should be 

as follows: 

(a) Why do we say that K.E=~ mv 2 ? Why not mv 2 or mv 3 I 

(b) Instead of mgh, if someone says that m2gh = P.E., do you think 

that the definition of energy as capacity of doing work remains the 

same ? 
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(c) Do you think that there is a system in the world where 

once it starts functioning, it keeps on working forever? 

(d) Can a machine be 100% efficient? If Yes/No. Why? 

(e) What advantages are there to measure energy in terms of 

calorie? 

If a pupil's answer is not in agreement with the existing formulae 

or definition, the word "wrong" is not to be used. For example, if 
,., 

a pupil says that K.E.= l/3 mvL(wnich in the book is said to be 

l/2 mv 2 , the pupil should not be discouraged, but should be allowed 

to carry on and find it for himself). (Of course, care is to be taken 

that the pupil does not draw conclusions from incomplete/discontinuous 

premises). 

Step III - General Exploratory Activities 

Present to the students some aspects on energy such as: 

(a) Utilisation of energy or energy consumption 

(b) Misutilisation of energy 

(c) Variation of wind speed 

(d) Radiant energy from the sun(solar heat) 

(e) Method of waste disposal/toilet system and estimation 

of energy which is to be obtained from the biomass conversion of 

the human excreta . 
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Give them time and opportunity to explore a wide variety of 

content with the one they are 1nterested 1n, so as to find a topic 

for further indepth study. 

Step IV - Group Training Activities 

In this step the teacher should make use of instructiona: 111ethods 

and techniques to help the learner to deal more effectively with 

content and which would also help to develop the high levels of thinking. 

Some of the teaching strategies suggested by William should be made 

use. These are: 

(a) Provocative questions 

(b) Ski 11 s of search 

(c) Tolerance for ambiguity 

(d) Intuitive expression 

(e) Adjustment to development 

(f) Evaluation of situation 

(g) Creative Reading Ski 11 

(h) Creative Writing Ski 11 

( i ) Visualization Skill 

Step V - Individual/Small Group Investigations 

Characteristics: 

(a) It must be voluntary 

(b) Groups/individual must be coordinated 

(c) Based on the particular activities, extra knowledge is 

to be provided by the teacher concerned (if necessary). 
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(d) In ca:;e of survey, necessary permission and legal formali­

ties are to be completed prior to the commencement of the projects. 

Some Suggested Activities 

Utilisation of Energy: 

1. Statistical data available easily like Petrol consumption 

in India from 1960 to 1980 per year (b) Daily energy consumption 

of a person. 

2. Data should be analysed and represented graphically showing 

calender years versus energy consumption of the nation, persons versus 

energy consumption. 

3. Make them aware of different levels of energy utilisation in 

different types of machine(degree of efficiency). 

e.g Machine 

(a) HERO HONDA 

100 cc Bike 

(b) Scooter Bajaj Super 

150 cc 

B. Survey on energy consumption 

l. Select 3 houses of affluent class 

3 houses of upper middle class 

3 houses of lower middle class 

Consumptions 

80 Kmll 1 itre 

35 Kmll litre 

in urban set-up 

2. Collect electricity bill, water bill, shopping bills for 3 

months. Make a survey of types of fuels used. 
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3. Prepare a report on energy consumption level, types of fuel, 

population level - suggest some remedial measures. 

4. Do the same activities in rural set up. 

Prepare a comparative study report on it. 

C. Survey of Electrical Energy Consumption in a Particular Locality 

1. Select a particular area 

2. Contact State Electricity Board Billing Section to collect 

data of billing for last 10 years. 

3. Draw graph of Bill vs months of the years - Bill versus years. 

4. Choose 3 establishments with very high, medium, low billing. 

5. With due permission, make a survey on how they utilise the 

energy. 

6. Suggest ways and means to minimise the consumption with alterna­

tive sources of energy such as solar water heater, wind mill water 

pump, fanless-well ventilated room, zero level dim light etc. 

7. Prepare a report to be submitted. 

D. Survey on Misutilisation of Energy: 

1. List out all the misutilisation/inefficient way of utilis­

ing energy e.g. A lot of smoke/unburned carbon in exhaust pipes of 

vehicles, not using pressure cooker, tube light etc. 

(b) Estimate the total loss of energy 

(c) List out its harmful environmental effect. 

(d) Suggest Remedies 

(e) Prepare a report 
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E. Non-Conventional Sources of Energy: 

(a) The teacher concerned or an official from Non-conventional 

Energy Department, or an expert from University could be invited 

for a lecture on .,Present trend in Non-conventional Sources of Energy., 

(b) Students are given access to the current research findings 

and latest development of design of non-conventional energy sources 

in their choosen area. 

(c) In consultation with the students involved some projects 

are listed e.g. windmill, solar cooker, biomass etc. 

(d) Any innovative idea towards the saving of energy by im­

proving/renovating/reforming the alrendy existed system or machines 

to be encouraged. 

F. Modelling: 

(If student/students choose a project e.g. Windmill). 

Tools to be provided: wooden saw, file, blade, scissor,knife, 

hammer, cellotape, gum, card paper etc. 

Teacher's Role: A teacher must act as an assistant, not as a supervisor, 

he must suggest and not overrule/dictate except when it is for safety. 

Steps involved: 

(a) The student should first make a static model of a windmill. 

(b) Based on this static/semi-working/working (mini) model, 

provisions should be made for the student to interact v1ith experts 

in the field to help the child sharpen his abilities.(Any kind of 
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disagreements should not end in arguments but the child should be 

helped to comrlete the model with design,calculation and verification). 

(c) All necessary knowledge (higher level) to be involved in 

the process of making the pilot project is to be taught to the pupils. 

(d) With necessary arrangement of financial assistance, the 

student should be instructed to make a working model. 

Step VI - Outlets for creation: 

(a) Present the findings in a seminar 

(b) Present findings in Children's Magazines which routinely 

publish children's writings and research summaries. If possible, 

arrange for Children's Art Shows or Science Fair to be as outlet 

for the Children's or Adolescent's products. 

(c) Based on the interest of the student, it is the duty of 

the teacher to decide whether a life-size pilot project of the same 

should be made. 



LESSON PLAN STEPS (HERBARTIAN APPROACH) 
 

LESSON PLAN 
Introduction 
            A lesson plan is the systematic preparation done in a scientific manner. Effective and 
successful teaching mainly depends on perfect lesson planning. A lesson plan represents a 
single teaching unit meant for a class period. Generally a lesson plan is teacher’s mental and 
emotional visualization of classroom activities. 
Definition 
            “Lesson plan is the title given to a statement of the achievement to be realized and 
the specific means by which these are to be attained as a result of the activities engaged in 
during the period”. 
                                                                                                            Bossing 
            “Daily lesson planning involves defining the objectives, selecting and arranging the 
subject matter and determining the method and procedure”. 
                                                                                                            Binging and Binging 
            Stands – A lesson is “A plan of action” 
Needs of Lesson Planning 
            The lesson plan does not allow the teacher to deviate and its keep him on the way. In 
the process of teaching, lesson plan is needed due to the following reasons. 
        i.            Through lesson plan, the teacher regularly achieves the teaching objectives and 
process in the form of complex objectives and processes. 
      ii.            A lesson plan develops the possibilities of adjustment in the classroom situation 
which makes the teaching effective. 
    iii.            A lesson plan helps in calling every step of curriculum unit. 
   iv.            A lesson plan helps in planning the process of teaching on the basis of class 
control, motivation and individual differences. 
IMPORTANCE OF LESSON PLAN 
            Planning is essential for every aspect of human activities, but for a planned teaching 
more planning is required. 
1.     Suitable Environment 
In a lesson plan objectives are fixed and the teaching strategies, techniques and material aid 
etc. are decided beforehand. When a proper teaching environment is created, the teaching 
task goes in a much planned way. 
2.     Based on previous knowledge 
In preparing lesson plans, the teacher presents new knowledge as the basis of previous 
knowledge of the pupils. This enables the pupils to gain the knowledge very conveniently on 
one side, the teacher succeeds in acquiring his objective on the other side. 
3.     Psychological teaching 
The teacher uses proper teaching strategies, techniques and instruments keeping in mind 
the interests, aptitudes, needs, capacities and abilities of the pupils for teaching them when 
the lesson plans are prepared. This makes the teaching more psychological. 
4.     Limitation of subject matter 
In a lesson plan, the subject matter becomes limited. This enables the teacher to give up 
irrelevant things. He only remembers definite and limited matter and its presentation 
before the pupils become easy. The pupils also receive the knowledge in a systematic and 
organized way. 



5.     Determination of activities 
In a lesson plan, the teachers and pupils activities are pre-decided according to the class 
level. This makes the teaching activities meaningful and purposeful. 
6.     Preparation of material aids 
At the time of preparing a lesson plan, the teacher decides what facts are to be clarified by 
what strategies, techniques and instruments and what aid is to be used at what time. This 
prepares the necessary and effective aids before starting the teaching task. 
 
7.     Developing of teaching skill 
The lesson plan acts as an important means for developing teaching skills in the pupil-
teacher. 
8.     Use of Theoretical knowledge 
Whatever the pupil-teachers get theoretical knowledge during their training period, that 
knowledge. 
9.     Teaching with confidence 
The preparation of a lesson plan makes the subject and other allied subjects more clearly to 
the teachers. This arouses self confidence among them. When a teacher gets developed the 
feeling of self-confidence, then he presents the new knowledge to the pupils with more 
enthusiasm and pleasure. 
10.                        Discipline in class 
By preparing lesson plan, the teacher becomes aware of what, when and how much is to be 
done in the class. This absorbs all the pupils in their respective tasks. Hence, it results in 
appreciable classroom discipline. 
11.                         Time sense 
Lesson plan is prepared allotting to the duration of the periods. 
12.                         Teaching from memory level to reflective level 
In an ideal lesson plan, development and thought provoking questions should be asked. Also 
there should be an effort to stretch the teaching from memory level to reflective level. 
 
CHARACTERISTICS OF GOOD LESSON PLAN 
1.     Objective based 
The lesson plan must be based on one or the other objective. While writing this, objectives 
should be written and defined clearly because its main objective is to achieve some goal. 
 
 
2.     Decision about appropriate material aids 
The material aid an important means of the teacher. Hence correct decision regarding the 
charts, graphs, pictures, diagrams and maps should be taken while preparing ideal lesson 
plan and these should be marked at proper places which a teacher is to use them while 
teaching. 
3.     Based previous knowledge 
An ideal lesson plan should be based on the previous knowledge of the pupils. This will 
avoid difficulty in acquiring new knowledge by the pupils. 
4.     Division of lesson plan in units 
Lessons are of three types (a) knowledge lesson (b) skill lesson (c) appreciation lesson. In an 
ideal lesson plan all the relevant steps of these three types of lesson plan should be 



determined. Each lesson should be divided into suitable units so that the pupils may 
understand the lesson gradually. 
5.     Simplicity of activities 
In an ideal lesson plan, the simplicity of the lesson plan and clarity of thoughts should be 
according to the mental level of the pupils. 
6.     Determination of activities 
In an ideal lesson plan, the activities of a teacher and the pupils should be determined 
before-hand. 
7.     Home work 
There should a provision of home work in an ideal lesson plan. This will enable the pupils to 
learn the appreciation of the acquired knowledge. 
8.     Self-evaluation 
A good lesson plan must have a suitable plan for self-criticism. The teacher should put some 
questions to him and find out the answer and there by judge the effectiveness of the lesson 
writing. 
9.     Use of illustration 
Examples should be used which have relevance with the daily life of the peoples. 
10.                         Use of blackboard 
The blackboard summary of each and every unit should be written on the blackboard. 
 
 
            This approach generally known as Herbartian five steps approach in the procedure of 
the Herbartian School of propagated by J.F.Herbart (1776-1841) and his followers. 
The formal steps involved in the approach as below 
                                i.            Introduction / Motivation 
                              ii.            Presentation 
                            iii.            Comparison and association 
                           iv.            Generalization 
                             v.            Application 
                           vi.            Recapitulation 
Introduction / Motivation 
            This step is concerned with the task of preparing the students for receiving new 
knowledge. In preparation, nothing new is taught to students. Relevant to the topic in hand 
he teacher should make himself sure of what the pupils already know, by putting a few 
questions, based on the pupils previous knowledge. In general, with the help of this step, 
the teacher can check the students entering behavior before he starts teaching the lesson. 
Thus, testing previous knowledge, developing interest in the minds of students and 
maintaining curiosity of the students can be achieved with the help of this step. 
The following activities involved in this step 
·        The assumption about the previous knowledge of the students in relevance to the 
lesson 
·        The testing of the previous knowledge 
·        Utilizing the previous knowledge for introducing the lesson 
·        Motivating the students for studying the present lesson 
 
 
Presentation 



            It is the key step and only through which the actual process of teaching is going to 
take place. Here the aims of the lesson should be stated clearly and the heading should be 
written on the blackboard. We have to provide situation for both the teacher and the 
students to participate in the process of teaching and learning. Our ultimate aim of the 
presentation is to make the concepts understandable to the students. Therefore simple 
language is used. Appropriate and specific examples and illustrations of the concepts will 
make the understanding better. The interest of the students on the subject matter should 
be maintained continuously by the way of asking questions from time to time in this stage. 
The teacher should carefully and skillfully arrange his material so that his pupils may clearly 
and readily grasp it. The teacher should make proper use of questions, charts, graphs, 
pictures, models and other illustrative for demonstration and explanation. 
            At the end of each section a few questions concerning that section only should be 
asked to whether the pupils are now ready for the acquisition of new knowledge. 
Comparison of Association 
            More importance should be given in this stage to compare the facts observed by the 
students with another concept by way of giving examples. By making use of this 
comparison, the students can derive definitions or theories. The students are encouraged to 
give new suitable examples for the concept instead of the examples given in the book to 
make them think in an innovative manner. 
Generalization 
            This step is concerned with arriving at some general ideas or drawing out the 
necessary conclusions by the students on the basis of the different comparisons, contracts 
and associated observed in the learning material present by the teacher. As far as possible 
the task of formulation should be left to students. The teacher at this stage should try to 
remain in the background for providing only necessary guidance and correction. 
Application 
            In this stage, the teacher makes the students to use the understood knowledge in an 
unfamiliar situation. Unless the knowledge of science is applied in new situations or in our 
day-to-day life, the study of science will become meaningless. This application of scientific 
principles will strengthen learning and will make the learning permanent. 
Recapitulation 
            This stage is meant for the teachers to know whether students have grasped by 
reviewing a lesson or by giving assignments to the students. Only through this step 
achieving closure (in teaching) is possible. 
 
INSTRUCTIONAL OBJECTIVES 
            Instructional objectives represent the desired change in the pupil who undergoes 
instruction in a lesson. There are two types of instructional objectives. They are 
1)    General Instructional Objectives 
2)    Specific Instructional Objectives 
When a teacher plans a lesson, he should ask himself, “Why should I teach this lesson?” The 
answer to this question constitutes Instructional objectives. All instruction will result in 
learning which in turn bring about changes in the behavior of the learners. So the 
instructional objectives it means the anticipated behavior change, which is what is what the 
teachers expect as a result of their teaching. 
1)    General Instructional Objective (GIO’s) 



            If the objectives are stated in general and vague manner, then they are called general 
objectives. They contain non-behavioral verb i.e. they contain non-action verb. 
For example; 
        i.            The learner acquires knowledge of the various branches of science. 
      ii.            The learner develops skill in manipulating apparatus. 
Here the verbs ‘acquires’ and ‘develops’ are non-action verbs which are cannot measure or 
observe directly, because they are in the form of inner development or passive aspect of 
mental activity. 
Example; 
            The pupil, 
                                            i.            Acquires knowledge of friction 
                                          ii.            Understands various types of friction 
                                        iii.            Applies knowledge of friction in relevant unfamiliar situation 
                                       iv.            Develops skill in doing experiments 
                                         v.            Develops interest in experimenting 
2)    Specific Instructional Objectives (SIO’s) 
If the objectives are stated in specific, then they are called specific objectives. They contain 
behavioral verb i.e. they contain ‘action’ verb. The observable and measurable behavioral 
changes as a result of realizing an objective is termed as specific instructional objectives or 
specification. 
For example 
            The learner defines friction 
            Here defines is the active verb 
            The statement of specification should contain two parts 
                                i.            Modification Part (MP) 
                              ii.            Content Part (CP) 
Example; 
The learner definesfriction 
                                                 MP         CP 
The table showing illustrative examples of specifications with specified behavioral part and 
content part from physical science. 

 
LEVEL 

SPECIFIC OBJECTIVE / SPECIFICATIONS 

THE BEHAVIORAL 
PART 

THE CONTENT PART 

 
 
KNOWLEDGE 

 
Recalls 
Recognizes 

 
The branches of science 

 
 
 
 
 
 

Distinguishes 
Identifies 
Selects 
Compares 
Classifies 
 

between metals and non-metals 
the physical properties of metals 
colored salts from the salts 
velocity and acceleration 
primary, secondary and tertiary alcohol 
 



 
UNDERSTANDING 

Identifies 
relationships 
Give examples 
 
Describes 
Explains 
 
Generalizes  

between rest and motion 
 
for first order lever 
 
the preparation of Iron 
the function of generator 
 
the ideas of input devices 

 
 
 
 
APPLICATION 

Gives reason 
Infers 
Computes 
Analyses 

Establishes 
relationships 
Suggests 
Selects 
Detects 

Give new 
illustrations 

Why sky appears blue? 
The result obtained in the experiment 
The normality of the liquid 
Analyses situations 
Establishes relationship between metals 
and non-metals 
Improvisation to apparatus 
Apparatus with purpose 
Detects errors 
For friction 

 
 
SKILL 

Draws 
Labels 

Doing 
experiments 
Participates 

The diagram of screw gauge 
The part of a generator 
Of simple pendulum 
 
In a science quiz 

 
 
INTEREST 

Collects 
Prepares 
Writes 
 
Organizes 

Picture of scientists, some machines etc. 
Posters on water pollution 
An article on ‘Globalization’ for school 
magazine 
Organizes science exhibition on ICT in 
Science Education 

 



LESSON PLAN



What is a Lesson?

• A lesson is a learning experience for an indl
or a gp and is acquired either through a 
structured interaction or by accident
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WHAT IS A PLAN?



A detailed proposal for doing or achieving 
something - Oxford

A series of actions that you think about carefully 
to help you to achieve something - Macmillan

A written account of intended future course of 
action (scheme) aimed at achieving specific goals or 
objs within a specific timeframe, with resources avl

It explains what needs to be done, when, how 
and by whom



Why is lesson planning important?

Lesson plg means making decisions in adv 
about what to teach, how to teach and the time 
assignment of every teaching procedure

• Teaching plan is necessary for both novice 
and experienced teachers

• Prep does not guarantee successful lessons, 
walking into a classroom unprepared is 
often the beginning of a disastrous lesson

• Although the main teaching contents may be 
the same, the students, the time and the 
mood are all different.



A Great

Lesson

There’s A LOT to a lesson





PLAN TO
• Wk out what you want to do
• Wk out if you can achieve what you want
• Think about how you want to achieve what 

you want
• Wk out any extra sp you might need
• Iden areas to focus upon & have more cont
• Think about what you want to do if 

something doesn’t wk out
• Think about changes
• Plan to make changes successful



A GOOD PLAN SHOULD
• Be  about what you want
• Incl all resources  / sp needed
• Have only things that you agree with
• Help you to do what you want
• Incl big picture (goals/Objs)
• Incl things that will make your plan happen
• List resp
• Incl time frames
• Be flexible to adopt to changes
• Be easy for you and every one to understand
• Should be a written docu
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Planning

• Designs the learning experience



Principles for Good Lesson Planning

• Aim: Should be simple & clear. The teacher has 
to set & achieve the realistic goals of the 
lesson

• Variety: Incl various activities and materials to 
ensure high motivation and interest

• Flexibility: Adopt more teaching methods & 
techniques - do not restrict to just reading / 
disseminating the lesson / its contents



Principles for Good Lesson Planning

• Learnability: the planned contents & tasks 
should be within learning capability of students. 

– doing things that are beyond or below the 
students’ coping ability will diminish their 
motivation (Schumann, 1999)

– Contents should be slightly higher than the 
present proficiency of the students 

• Linkage: the teaching steps should be linked 
with each other. That is, there should be 
coherence.



Macro Planning vs. Micro Planning

• Macro planning - planning over a 
longer period of time. Planning for the 
entire subject / course

• Macro planning is not writing lesson 
plans for specific lessons but rather 
helping teachers get an overall felling 
or idea about the course and also get 
familiarized with the context in which 
teaching will takes place 



Macro planning involves

• Knowing about the profession:
Get to know what should be taught / practised
in the course, what materials and teaching 
aids are available, and what methods and 
techniques can be used.

• Knowing about the institution: 
The teacher should get to know the institution’s 
arrangements regarding time, length, 
frequency of lessons, physical conditions of 
classrooms, and exam requirements. 



• Knowing about the learners:

Acquire information about the students’ age, 
service bracket, motivation, attitudes, 
interests, learning needs & other factors

• Knowing about the curriculum/syllabus:

The teacher should be clear about the 
purposes, requirements    and targets 
specified in the syllabus.



• Knowing about the textbook:

Know the textbook well in terms of methods of 
teaching, organization of learning contents, 
major topics, recommend teaching methodology, 
unit components and ways of assessment.

• Knowing about the objectives: 

Know what learners are expected to achieve and 
able to do after the course

• Macro planning provides a general guidance for 
teachers, but it is not enough for good teaching. 
Teachers need to plan each lesson in detail in order 
to teach effectively and confidently in the classroom.



• Lesson Plans not made
• Learning Objs either not enunciated / poorly 

written
• Timelines not allotted based on content
• No time planned for interaction
• Trg aids not planned
• Lesson assessment not connected with 

behavior indicated in the obj
• No activities planned to promote interaction

Common mistakes in Lesson Plans



MATHEMATICS 

LABORATORY

Mathematics Laboratory is a place where students can learn and 

explore mathematical concepts and verify mathematical facts 

and theorems through a variety of activities using different 

materials.These activities may be carried out by the teacher or 

the student to explore, to learn, to stimulate interest and develop 

favourable attitude towards mathematics.

Laboratory in Mathematics is the brain child of Mr.Sreedhara 

Chandra Sekhara Sastry, a creative mathematician. The Maths 

Lab consists of more than 200 models in 

various branchers of maths like Algebra, 

Geometry, Arithmetics,etc. which are of 

great help to students from K.G to 

12th.The models are so designed to catter 

to the needs of all segments of teachers 

and learners in verifying formulae results 

and applications etc., irrespective of curriculum.

      It is true that the Mathematics laboratory bar has not 

yet received the same general acceptance as a Science 

laboratory. This is probably because the mathematics teachers 

themselves have no recognized the significance of mathematics 

laboratory as the Science teachers have. Actually most 

mathematical teachers have been very passive as to this respect. 



Need & Significance of Mathematics Laboratory

Recently, Laboratory works in Mathematics in receiving in 

creating attention. The underlying idea of a Mathematical Lab is 

that people will develop new concepts and understanding 

particularly well through experimental activities dealing with 

concrete situation. They can be learned better through 

observation of the concrete situations and experiments and 

manipulation

of concrete objects. Activities such as measuring and drawing, 

counting ,weighing, averaging & estimating ,taking the readings 

from instruments, recording comparing ,analyzing ,classifying 

and checking data, collecting data ,working with data and so on 

will involve the use of physical instruments and can be labeled 

as laboratory work. Some of this work can be done in the 

classroom that is suitable arranged and equipped (mathematics 

Laboratory) and some can take the form of elementary field 

work. Most students find such work highly interesting and 

through such activities they can develop many Mathematical 

Concepts and insight with an interest and a clarify often not 

attained through a strictly intellectual approach.           



                 The activities involved in laboratory type work in 

Mathematics fall broadly into two classes, namely 

demonstrations and ‘experimental activities’. In demonstration 

some physical instrument or device is used to illustrate and 

clarify the explanation of a Mathematical Concept or a method.

                 Experimental activities include the kind of activities 

which are carried on individually or by small groups working 

together and are primarily aimed at helping experiments 

themselves to understand concepts/ideas  clearly. In the high 

school mathematics, properties of geometric figures and 

concepts of distance, angles, weights, areas, volumes and     

etc.can are given a monivivid impact through experimental 

activities than through any other means.    

Materials & Equipments for a Mathematics 

Laboratory 



                 For the effective functioning of a Mathematics 

Laboratory, it should be well occupied. A mathematics Lab may 

contain the following type of materials & equipments. 

Materials

*  Concrete Materials 

     
                

                The Mathematics Lab should contain materials such as 

beads, pebbles, sticks ball frames, seeds, balances, weight 

measuring tapes,scisssors,pins,abacus, carboard,boardpins, chart 

paper, graph paper,etc. which are very helpful for demonstrating 

elementary mathematical concepts. 

 *  Pictures & Charts 

                



                Pictures & Charts depicting different mathematical 

concepts should find a place in a Mathematics Laboratory, 

Pictures of Mathematicians; charts showing the contributions o 

mathematician, History of Mathematics, biographers of 

mathematicians are also very helpful for demonstrating students 

and can be placed in the Mathematical Lab.

* Models

               

Various Mathematical models which will 

offer opportunities for students to explore 

and investigate should be placed in the 

mathematical Laboratory.

* Bulletin Board

   

               There should be at least one bulletin board in the 

mathematics laboratory to display various illustrations 

concerning mathematics. Information relating to Mathematics 

and its application collected from different sources like 

Magazines, Journals & Newspapers can be displayed for the 

benefit of the peoples.



* Black Board
            

                A Blackboard should be 

provided in the mathematics 

lab. This helps in writing 

instructions, drawing 

geometrical figures and 

illustrations necessary for 

performing the laboratory work.

Instruments & Equipments.

 
* Drawing Instruments

                In Mathematics Lab, the students are required to draw 

and sketch geometrical figures, graphs and so on. Therefore in 

every Mathematics lab there should be a set of drawing 

instruments like compass, rulers, protractor, etc. for the teachers 

to demonstrate the drawing on the black board and instrument 

boxes for the students’ use.

  * Weighing & Measuring Instruments

        

                Mathematics Lab work quite often, involve the 

important activities of weighing and measuring. Therefore, 

instruments used for measuring 

tapes, balances of different types 

measuring jar and graduated cylinder 

should be there in a mathematics lab.

 



* Surveying Instruments

   

         Laying out right angles, finding the angular distance, 

estimating weight of a building, estimating the distance of an 

object, finding the angle of elevation and depression are all 

useful activities which make use of surveying instruments.

 * Proportional Dividers

         This instruments works on the principle of proportionality 

of similar triangles. It can be used for enlarging or reducing 

figures, pictures, maps, graphs, etc. 



Functions of a Mathematics Laboratory
      

  

The primary functions of a mathematics lab are to:

• Make Mathematics teaching & learning interesting and 

purposeful for the students.

• Provide activities that arouse the curiosity of the students 

& maintain their interest in learning.

•  Enable students to develop proper skills in handling 

equipments & gadgets.

•  Make students appreciate the practical applicability of       

Mathematical Principles and laws.

•  Concretized the abstract Mathematical Concepts.

• Help the students develop powers of observation, analysis 

and drawing inferences.



Do your students rejoice mathematics or are phobic to it?

"The essence of mathematics is not to make simple things complicated but to make 

complicated things simple."

CONCLUSION

Mathematics Laboratory is a place where students can learn and explore 
mathematical concepts and verify mathematical facts and theorems through a 
variety of activities using different materials.These activities may be carried 
out by the teacher or the student to explore, to learn, to stimulate interest and 
develop favourable attitude towards mathematics.

THE END



Objective Type Test: Meaning, 
Merits and Limitations |  
After reading this, you will learn about:- 1. Meaning of Objective 
Type Test 2. Merits of Objective Type Test 3. Limitations 4. 
Construction. 

Meaning of Objective Type Test: 
Simply, an objective type test is one which is free from any 
subjective bias either from the tester or the marker. It refers to any 
written test that requires the examinee to select the correct answer 
from among one or more of several alternatives or supply a word or 
two and that demands an objective judgement when it is scored. 

Objective-Centered Test/Objective based Test: 
When questions are framed with reference to the objectives of 
instruction, the test becomes objective-based. This type of test may 
contain essay type and objective type test items. 

An essay test may be objective-centered or objective-based, though 
it may be difficult to score it objectively. An objective type test, on 
the other hand, can always be scored objectively, though it may not 
be objective-centered if it is not planned with reference to the 
objectives of instruction. 

Objective-type tests have two characteristics viz.: 
1. They are pin-pointed, definite and so clear that a single, definite 
answer is expected. 

2. They ensure perfect objectivity in scoring. The scoring will not 
vary from examiner to examiner. 



Merits of Objective Type Test: 
1. Objective type test gives scope for wider sampling of the content. 

2. It can be scored objectively and easily. The scoring will not vary 
from time to time or from examiner to examiner. 

3. This test reduces (a) the role of luck and (b) cramming of 
expected questions. As a result, there is greater reliability and better 
content validity. 

4. This type of question has greater motivational value. 

5. It possesses economy of time, for it takes less time to answer than 
an essay test. Comparatively, many test items can be presented to 
students. It also saves a let of time of the scorer. 

6. It eliminates extraneous (irrelevant) factors such as speed of 
writing, fluency of expression, literary style, good handwriting, 
neatness, etc. 

7. It measures the higher mental processes of understanding, 
application, analysis, prediction and interpretation. 

8. It permits stencil, machine or clerical scoring. Thus scoring is 
very easy. 

9. Linguistic ability is not required. 

Limitations of Objective Type Test: 
1. Objectives like ability to organise matter, ability to present matter 
logically and in a coherent fashion, etc., cannot be evaluated. 



2. Guessing is possible. No doubt the chances of success may be 
reduced by the inclusion of a large number of items. 

3. If a respondent marks all responses as correct, the result may be 
misleading. 

4. Construction of the objective test items is difficult while 
answering them is quite easy. 

5. They demand more of analysis than synthesis. 

6. Linguistic ability of the testee is not at all tested. 

7. Printing cost considerably greater than that of an essay test. 

Guidelines for Constructing Better Objective Type Test 
Items: 
To be a good item writer, one should have: 
(a) A thorough understanding of the subject matter; 

(b) A thorough understanding of the pupils tested; 

(c) Perseverance; and 

(d) A little creativity to prepare fertile kind of items. 

It is of paramount importance for him to be cognizant of the pitfalls 
involved in writing objective type test items. 

We shall now offer some general guidelines for the writing 
of objective type test items: 
1. Each item must be clearly expressed i.e. there must be precision 
in writing the test items. 



2. Test for important facts and knowledge and not for trivial details; 
e.g., 

 (a) Give the name of the ship that Columbus was on when he 
discovered America. 

(b) Give the date (and/or time) when Edison invented the light 
bulb. 

These items test the ability to recall or supple trivial details and 
therefore are unsound. 

3. Avoid ambiguous statements. Each item should be subjected to 
one and only one interpretation. 

Poor: 
Rabindranath Tagore wrote Gitanjali in……….. The item is 
ambiguous because the examinee does not know whether the 
teacher wants to know the year, the date, the language or the place. 

Better: 
In which language did Rabindranath Tagore write Gitanjali? 

4. Quantitative rather than qualitative words should be used. Words 
such as few, many, low, high, large, etc. are vague, indefinite, and, 
therefore, should be avoided. 

Poor: 
TF Many people are literate in Orissa. 

Better: 
TF About 85% of the people are literate in Orissa. 



5. Use good grammar and sentence structure to improve clarity. 

Poor: 
TF In a triangle, whose one of the angle’s measure is 90°, the 
hypotenuse is equal to the square root of the sum of the squares of 
the other two sides. 

Better: 
TF In a right-angled triangle, the square on the hypotenuse is equal 
to the sum of the squares on the other two sides. 

6. Avoid lifting statements verbatim from the text-book. The use of 
text book language in a test encourages a pupil to memorise rather 
than to understand the subject matter. 

7. There should be only one correct answer. 

Poor: 
Fill in the blank by inserting an operational symbol. 

2……… 2 = 4 

Here, some students may write +, others may write X. 

8. Avoid negative questions whenever possible. An indiscriminate 
use of the negative should be avoided. It takes more time to answer. 

Poor: 
TF The longitude of Bombay is not 73°E. 

Better: 
TF The longitude of Bombay is 73°E. 



9. Directions to questions should be specific. Ambiguous wording 
and double negatives should be avoided in questions. 
 



  
Page 2  

  

Contents 

The challenge .....................................................................................................................................4 

Assumptions ......................................................................................................................................4 

The best tool for the job .....................................................................................................................4 

Office Open XML file format ...............................................................................................................4 

Creating transportable PowerPoint presentations ..............................................................................4 

Customizing PowerPoint ....................................................................................................................6 

“End with black slide” ............................................................................................................................... 6 

“Customize” .............................................................................................................................................. 6 

I want my menus back! (Office 2003 & earlier, Windows only) ........................................................................... 6 
Equation Editor icon (Office 2004 and earlier, Windows & Macintosh) ............................................................... 6 
Drawing Toolbar (All versions of PowerPoint for Windows & Macintosh except PowerPoint 2007) .................. 7 
Quick Access Toolbar (Office 2007 only) .............................................................................................................. 7 

Templates & Themes .........................................................................................................................7 

Using AutoShapes ..............................................................................................................................9 

Customize your Drawing Toolbar .............................................................................................................. 9 

The Shift key is your friend ....................................................................................................................... 9 

Drawing lines ........................................................................................................................................................ 9 
Similar shapes ....................................................................................................................................................... 9 

Snap to grid/Snap to shapes ................................................................................................................... 10 

Equations and Graphs ...................................................................................................................... 10 

Equations with Equation Editor & MathType ......................................................................................... 10 

1. Changing the size of equations ....................................................................................................................... 10 
2. Grouping equations and text boxes ................................................................................................................ 10 

Adding graphs to your slides ................................................................................................................... 11 

Using Excel or other spreadsheets ...................................................................................................................... 12 
Using Autograph or other commercial software ................................................................................................ 12 
Free software ...................................................................................................................................................... 12 

Interaction ....................................................................................................................................... 12 

Action buttons ........................................................................................................................................ 13 

Design Principles .............................................................................................................................. 14 

Contrast ................................................................................................................................................... 14 

Design Template/Theme .................................................................................................................................... 14 
Focus attention on part of an equation with a contrasting color ....................................................................... 14 

Alignment ................................................................................................................................................ 14 

Rule of Thirds ...................................................................................................................................................... 15 
Alignment of equations ...................................................................................................................................... 16 



  
Page 3  

  

Presenter View ................................................................................................................................ 16 

Turning Presenter View on and off ......................................................................................................... 17 

Conclusion ....................................................................................................................................... 17 

Appendix 1:  Resources for using PowerPoint as a math or science teacher ....................................... 18 
Websites ............................................................................................................................................................. 18 
Software.............................................................................................................................................................. 18 
Blogs & Newsletters ............................................................................................................................................ 18 
Books .................................................................................................................................................................. 18 
Miscellaneous ..................................................................................................................................................... 18 

Appendix 2: Using macros with action buttons to create an interactive quiz (not PPT 2008) ............... 19 

Step 1: Create the question slides .......................................................................................................... 19 

Step 2: Create macros ............................................................................................................................. 19 

Step 2a: If you’re using PowerPoint 2004… ........................................................................................................ 21 
Step 3: Attach macros to buttons ........................................................................................................... 21 

 

  



  
Page 4  

  

The challenge 

Anyone who’s been teaching for longer than a day understands the fact that communicating certain 

ideas to our students is a real challenge. PowerPoint is a tool that can make that task easier, but it can 

also serve as a barrier to effective communication. Our specific challenge when using PowerPoint is to 

use it so that it’s truly a learning tool and not a distraction. This handout will cover several topics that 

will help you use PowerPoint more effectively as a math or science teacher.  

Assumptions 

Before we proceed, I must mention that I’m making four assumptions about you: 

1. You’re already using PowerPoint, and you’re not expecting this to be a “how-to” tutorial about 

how to use it. 

2. You’re already using either the Equation Editor that’s built-in to Microsoft Office, or its more 

feature-packed big brother, MathType. 

3. You’re fairly competent in both, but you don’t consider yourself an expert in either. 

4. You’ll pass along to me any tips you have that you’ve gathered from years of teaching with 

PowerPoint. 

The best tool for the job 

From time to time it may be the case that for the particular topic you’re presenting, PowerPoint may not 

be the best tool for the job. That’s what you get the big “teacher bucks” for—to decide what’s best for 

each lesson. 

Office Open XML file format 

This is the official name of Microsoft’s new document format that was introduced with Office 2007 for 

Windows, and is also incorporated into Office 2008 for Macintosh. Don’t confuse the term Office Open 
XML with a similar-sounding product, Open Office. The latter is a free office suite; the former is a 

document format. Whether you’re using Office 2007/2008 or not, it’s important to realize that the 

document format is different from that of previous Office versions. If you’re using an earlier version of 

Office, you can’t open documents created in Office 2007/2008 without downloading the file converters 

from Microsoft. Here’s where to get them: 

• For Windows: http://tinyurl.com/y5a879 

• For Macintosh: http://tinyurl.com/35yel7  ←  That's a lower-case "L", not a "1" next to the 7.  

Creating transportable PowerPoint presentations 

If you’ve done much PowerPoint, you’ve no doubt been there – you’ve slaved until midnight making 

your presentation perfect, and you load it on your USB flash drive to take to school. You arrive at your 

classroom only to discover there’s been a broken water pipe and you’ll have to use a different classroom 
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today. You fire up the computer in the new room and begin showing the lesson to your students when 

one of them points out that some of your equations look funny. Sure enough, some symbols are missing 

and other symbols are replaced by other, seemingly random, symbols. What’s the problem? 

The problem is caused by the fact that MathType creates equations with fonts. If the computer you’re 

showing your presentation on (or printing your Word document from) doesn’t have the MathType fonts 

installed, your equations won’t look right. What’s a teacher to do? 

Luckily there are several solutions, all of which are fairly easy. Some of them can be difficult, depending 

on how hard your technology guru is to get along with, but at least one of them you can do yourself (and 

that one won’t work on the Mac! If you’re a Mac user, your options are 1, 2, or 3 below): 

1. If your school has a school license for MathType, it’s perfectly all right to install MathType on the 

network or to install it on each individual computer at the school. You can even use it at home and 

load it on student laptops (K-12 schools only, not colleges) – all under the same school license! 

2. If you don’t have a site license for MathType, it’s OK to load the MathType fonts onto any computer 

you want them on. If you have a MathType CD, they’re on the CD. If you have MathType installed on 

a home computer or a laptop, they’re in your MathType folder in a sub-folder labeled Fonts. Just 

copy them over. (Check with your IT person if you’re not sure where they go.) 

3. Download the MathType trial version from our website: www.dessci.com. You can install it on 

whatever computers you want it on, and even after the 30-day trial period expires, the computers 

you’ve loaded it on will continue to be able to show PowerPoint presentations and print Word 

documents with MathType equations in them. 

4. Embed the fonts in your presentation. There are just a few easy steps to accomplish. (This is the one 

you can’t do on the Mac.) The steps are similar to accomplish the same thing in Word. 

a. Click View > Master > Slide Master. (In PowerPoint 2007, it's View > Slide Master.) 

i. On the Title Master, click inside the Footer. 

ii. Change the font to MT Extra. Press the spacebar. Repeat this step for each equation 

font you need to embed. You don't need to embed any font you've used in the text 

of your slides nor any “standard” font you've used in your equations (like Symbol). 

iii. On the Slide Master View toolbar or tab, click Close Master View. 

b. Save the document. If you've saved it previously, use the Save As command. 

c. In the Save As dialog, click Tools. This will be in the upper right of the dialog unless you're 

using Office 2007, in which case it will be in the lower left. 

d. Choose Save Options. 

i. In PowerPoint 2003 & earlier, click the box labeled Embed TrueType fonts. Leave 

other default options set. Specifically, do not click the box labeled “Embed 

characters in use only”, because this will result in embedding only the space 

character from the math fonts. Click OK, then click Save (naming the presentation 

first, if you haven't already done that). 

ii. In PowerPoint 2007, click the box labeled Embed fonts in the file, then click the 

button labeled Embed all characters. Click OK, then click Save (naming the 

presentation first, if you haven't already done that). 
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Customizing PowerPoint 

The first step in getting more out of PowerPoint is to customize it.  

“End with black slide” 

This is the only customization I consider an “absolute”. What you don’t want to happen is to get to the 

end of your presentation, and when you click the mouse one more time, the slide show ends and what 

the audience sees is your PowerPoint screen with all the toolbars, etc. Very unprofessional. To make this 

change, click on Tools > Options > View. Check the box labeled “End with black slide”. 

Mac: PowerPoint > Preferences > View. 

PowerPoint 2007: Office Button > PowerPoint Options > Advanced > Slide Show. 

While you’re in the Options or Preferences dialog, do yourself a favor and take the time to explore the 

other custom settings available to you there. (I don’t just mean the ones mentioned in this handout; I 

mean all of them!) 

“Customize” 

In the software world, I know of only one thing the word customize means, and that’s to change the layout 

of your menus and/or toolbars. On both Windows and Macintosh versions of PowerPoint earlier than 

PowerPoint 2007, this item appears on the Tools menu. On PowerPoint for Mac, there is a separate fly-out 

menu with two items on it. Choose the item labeled “Customize Toolbars/Menus”. (On Windows, just click 

Tools > Customize.) If you’re using Office 2007, read on, because parts of this section still apply to you. 

I want my menus back! (Office 2003 & earlier, Windows only) 
The first thing I recommend changing on the Customize dialog applies only to Office 

for Windows, and applies equally to Word, PowerPoint, and Excel. If you are one of 

the few people who actually like the style of menus you see at the right, then skip to 

the next section. If you prefer to get the entire menu when you click it, rather than 

having to wait for what seems like forever before the menu expands, just click on the 

Options tab in the Customize dialog and select the option labeled Always Show Full 
Menus. While you’re there though, I recommend also checking the box labeled Show 
Standard and Formatting toolbars on two rows. I recommend this option because 

that lets you see your entire toolbar without scrolling to the right or clicking the 

“expand” button. 

Equation Editor icon (Office 2004 and earlier, Windows & Macintosh) 
(This step is not necessary for MathType users.) On the Customize dialog (Mac: “Customize 

Toolbars/Menus”) click the Commands tab. In the Categories section, click Insert. In the Commands 

pane on the right, scroll down until you find the Equation Editor icon. Click and drag it to your toolbar. 

While you’re there, go ahead and look to see if there are other icons you want on your toolbar. Likewise, 

if there are icons on your toolbar you don’t use, simply drag them off. You can always put them back on 

the toolbar later, and now you know how! 
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Drawing Toolbar (All versions of PowerPoint for Windows & Macintosh except PowerPoint 2007) 
For now, click Close to close the Customize dialog (Mac: click OK). Click on the View menu and hover 

over the Toolbars fly-out menu and you’ll see a list of all the toolbars available. The ones that are 

checked are the ones you’re currently using. If Drawing is not checked, click it to select it. The default 

location for the Drawing Toolbar is the bottom of the window for PowerPoint for Windows, and the left 

side of the screen on the Mac. Now that this toolbar is visible, go back to the Customize dialog and add 

icons to make it more usable. Here’s what my Drawing Toolbar looks like for PowerPoint 2003: 

 

Quick Access Toolbar (Office 2007 only) 
In Office 2007 for Windows, the only customizations you can make easily are adding things to and 

removing things from the “Quick Access Toolbar”, or QAT for short. The easiest way to do that is to 

right-click an item on the Ribbon and choose the command labeled “Add to Quick Access Toolbar”. For 

more control, click the  icon and click “More Commands”. 

Templates & Themes 

PowerPoint is so feature-packed that it’s easy for two things to happen. First, it’s easy to let yourself get 

so wrapped up in discovering all of PowerPoint’s cool features that you don’t have time to prepare your 

lesson. Second, once you discover a cool feature, you want to try it out on your class. Trying out new 

features is something I definitely encourage, but not when it distracts from the lesson. PowerPoint’s 

Design Templates (Office 2007 & 2008: “Themes”) are definitely in the category of things that can 

distract if you let them. From this point forward, when the discussion applies equally both to Templates 

and Themes, I’ll simply refer to Templates. 

When it comes to templates, you basically have 3 choices: 

1. You can use a standard template (i.e., one that came with PowerPoint). 

2. You can create your own template or use one that someone else created. We have a guided 

tutorial that shows how to create your own design template: www.dessci.com/template 

3. Don’t use one. Even if you go this route though, you’re still using one. The template titled 

“blank.pot” is what the new presentation is based on that appears when you first open 

PowerPoint (for PowerPoint 2007, it’s the theme titled “blank.pptx”). 

Whichever of these choices you make, I have 2 recommendations. First, keep your slides simple—as 

simple as you can make the slide and still get your message across. Second, if you use a template other 

than “blank”, either create your own or use one based on a simple design. 

Compare the two slides on the next page. Which one do you think would be more effective? 
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Using AutoShapes 

PowerPoint’s AutoShapes are practically indispensible for teaching math, and the better you know how 

to use them, the more often you’ll use them, and the more effective you’ll be at it. (In Office 2007 & 

2008, AutoShapes are just called “Shapes”, but in this handout we’ll use the term “AutoShape” to refer 

to them all.) Although this will not be even close to a full tutorial on using AutoShapes, I have a few 

suggestions. 

Customize your Drawing Toolbar 

Before you even start thinking about using AutoShapes, you should put the most commonly-used items 

on the drawing toolbar. Space-permitting, I recommend these items as a minimum (some of them are 

there by default): Grid settings; Group, Ungroup, & Re-group; Mirror; Flip; Send to Front; Send to Back; 

Align Left, Center, Right, Top, Middle, Bottom; Fill On/Off; Line On/Off. 

The way you use AutoShapes is to select the one you want, and click on it. When you do that, your 

cursor changes to this one: . Click on your slide where you want to start drawing the AutoShape, and 

drag to draw it. That’s pretty much all there is to it, but knowing a few additional techniques will make 

your life easier… 

The Shift key is your friend 

You’ll notice there’s quite a limited assortment of shapes, but by knowing how to use the Shift key, you 

can get some that aren’t on the palette. For example, there’s no equilateral triangle, but there is an 

isosceles triangle. You could choose isosceles triangle and drag the mouse until you have what looks like 

an equilateral triangle, but all you need to do is to hold down the Shift key as you drag, and the 

proportions will be constrained so that you have an equilateral triangle. In general, the Shift key makes 
a regular polygon out of any polygon on the palette. 

Drawing lines 

Since a line is not a polygon, what’s the effect of the Shift key on the line AutoShape? If you depress the 

Shift key as you drag the mouse to draw a line, the line will be horizontal, vertical, or at an angle that’s a 

multiple of 15°. This default of 15° cannot be changed, but is very useful information to remember. 

Similar shapes 

Another use of the Shift key is for creating similar shapes. Let’s say you have a 3-4-5 right 

triangle, and you want to create a similar one and arrange them so their hypotenuses are 

tangent and vertices touching – like the 2 triangles to the right. Just copy & paste the first one, 

and when you re-size the copy, hold down the Shift key and drag until it’s the size you want. 

Keeping the Shift key depressed will keep the original triangle’s proportions, but it’s important 

that you release the mouse button before releasing the Shift key. If you mistakenly release the Shift key 

first, just press Ctrl+Z (undo – Ì+Z Mac), and try it again. 
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Snap to grid/Snap to shapes 

When working with AutoShapes, you’ll almost always want your grid setting set so that “Snap to grid” is 

not checked, and “Snap to shapes” (or “Snap to other objects”) is checked. You’ll find these in the Grid 

and Guides dialog. In PowerPoint 2003 click Draw > Grid and Guides. In PowerPoint 2004, click the  

icon, then in the Snap flyout menu, make sure “To Grid” is not checked and “To Shape” is checked. In 

PowerPoint 2008, it’s View > Guides > Snap to Grid & Snap to Shape. In PowerPoint 2007, find the 

Drawing group on the Home tab of the Ribbon. Click Arrange > Align > Grid Settings. 

Equations and Graphs 

Equations with Equation Editor & MathType 

We have a full tutorial on our website that deals with Using MathType with PowerPoint. Although this 

tutorial doesn’t specifically deal with Equation Editor, if you’re using Equation Editor, you can still 

benefit from the tutorial. You can read this tutorial at www.dessci.com/ppt. Since the tutorial deals with 

all the issues involved in using equations in your slides, we won’t handle that here. There are, however, 

two important equation-related issues that are important to mention. 

1. Changing the size of equations 

The right way to change the size of an equation is by going through the Size menu; the wrong way to do 

it is to drag the corner of an equation to make it larger. To do it the right way, click Size > Define, and set 

the Full size to be the same size as your text in PowerPoint. If you’re using MathType, the remaining 

sizes will be defined as percentages of Full size, and you can leave them as they are. If you’re using 

Equation Editor, you’ll have to change this, but once you change it you can leave it set for both Word & 

PowerPoint. Set the Full size as described above. For the remaining sizes, Subscript/Superscript, Sub-

Subscript/ Superscript, Symbol, and Sub-symbol, use these values: 58%, 42%, 150%, and 100%, 

respectively. (Be sure to type the % symbol.) 

There are at least two reasons why dragging the corner of an equation is the wrong way to do it. First, if 

you do that, no two equations in your presentation will be exactly the same size, and none of them will 

be the same size as the text on your slide. You’re using Equation Editor/MathType so that your 

presentation looks perfect; you’re not using them so your presentation will look “good enough”, so you 

might as well size your equations the right way. The second reason you shouldn’t drag an equation’s 

corner to resize it is because this will sometimes cause problems like reversed (mirror-image) equations, 

and you may not notice this until you’re presenting the lesson to your class! 

2. Grouping equations and text boxes 

First, let’s make sure we understand ourselves. The phrase “text box” refers to something very specific. 

It does not refer to the area in PowerPoint where you normally type your “bullet text”. That area is 

called a “placeholder”. If you want a text box on your slide, you must specifically insert one. See the 

screen shot on the next page. By “grouping”, we mean selecting multiple objects on a slide and grouping 

them together so they act as one object (primarily for the purpose of animation). 



  
 

Simple subject here: PowerPoint does not allow you to group a placeholder with any object, whether 

that object is an equation, clip art, or any other object. A text box, however, is treated just like any other 

object, and you can group it with an equation or any other object.

Adding graphs to your slides

When it comes to graphs, you basically have 5 choices, three of which are w

1. You can use what you’ve already got. Presumably you’ve got Microsoft Office if you’re using 

PowerPoint, and you can create graphs with Excel and paste them into PowerPoint. If you’re 

using a different office suite, such as Open Offi

spreadsheet application as part of the suite

2. You can use commercial software, such as Autograph.

3. You can use free software, such as WinPlot, GCalc, or Graph.

4. You could write your own graphing software.

5. You could sketch the graph by hand, scan it, and insert the scanned graph into PowerPoint.

We’ll not even consider choices 4 and 5.
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Using Excel or other spreadsheets

To get a usable graph from a spreadsheet, you’ll need to enter an 

graph from this table. Of course, the more inflection points your graph has, the more points you’ll need 

to include in the table if you want a smooth graph

corresponding table of values. 

Graph created with Excel, and the table of values used for the graph

Using Autograph or other commercial software

Excel is adequate for simple graphs like the one above, but for more complex graphs or for special needs 

such as conic sections and other relations, you might want to consider Autograph ($165) or other 

commercial software. 

Free software 

Most of the time you get what you pay

down versions of products you’d normally have to pay money for. In the case of graphing software 

though, there are at least 3 really impressive and feature

Graph. The appendix to this handout gives the URLs where you can download these products.

Interaction 

Interaction is the key to producing things like educational games and quizzes with PowerPoint. 

Interaction is achieved by combining animation, action 
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for, and many free software applications are simply stripped-

down versions of products you’d normally have to pay money for. In the case of graphing software 

Winplot, GCalc, and 

Graph. The appendix to this handout gives the URLs where you can download these products. 

Interaction is the key to producing things like educational games and quizzes with PowerPoint. 

buttons, and action settings. Animation is a basic 

y 

9 

4 

1 

0 

1 

4 

9 



  
 

PowerPoint feature, and although there are some really advanced ways to use animation, we’ll not 

cover those techniques here. 

Action buttons 

Action Buttons are a special type of AutoShape. What’s special a

drag the mouse to “draw” the button, an “Action Settings” dialog appears, giving you a pretty good 

variety of options of things you can do when you click or 

during the presentation. You can do things like hyperlink to another slide in the current presentation, 

hyperlink to a slide in another presentation, run a program, open a file, play a sound or a movie, etc. 

Since we’ll be creating quizzes, the most useful of these actions is 

current presentation. 

Actually, in this example, you don’t 

link to the next slide in the deck, and clicking anywhere on the slide will take you there

the buttons are there though—if they weren’t there, it wouldn’t take long for the students to figure out 

that the correct answer is the one with the Action Button! Of course if you want to, you can build the 

slides for the incorrect responses such that the slide explains why the response was incorrect. In that 
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PowerPoint feature, and although there are some really advanced ways to use animation, we’ll not 

Action Buttons are a special type of AutoShape. What’s special about Action Buttons is that after you 

drag the mouse to “draw” the button, an “Action Settings” dialog appears, giving you a pretty good 

variety of options of things you can do when you click or hover the mouse pointer over

on. You can do things like hyperlink to another slide in the current presentation, 

n another presentation, run a program, open a file, play a sound or a movie, etc. 

Since we’ll be creating quizzes, the most useful of these actions is hyperlink to another slide in the 

Actually, in this example, you don’t really need Action Buttons for the incorrect responses since they just 

link to the next slide in the deck, and clicking anywhere on the slide will take you there

if they weren’t there, it wouldn’t take long for the students to figure out 

that the correct answer is the one with the Action Button! Of course if you want to, you can build the 

onses such that the slide explains why the response was incorrect. In that 

PowerPoint feature, and although there are some really advanced ways to use animation, we’ll not 

bout Action Buttons is that after you 

drag the mouse to “draw” the button, an “Action Settings” dialog appears, giving you a pretty good 

hover the mouse pointer over the button 

on. You can do things like hyperlink to another slide in the current presentation, 

n another presentation, run a program, open a file, play a sound or a movie, etc. 

hyperlink to another slide in the 

 

need Action Buttons for the incorrect responses since they just 

link to the next slide in the deck, and clicking anywhere on the slide will take you there. It’s obvious why 

if they weren’t there, it wouldn’t take long for the students to figure out 

that the correct answer is the one with the Action Button! Of course if you want to, you can build the 

onses such that the slide explains why the response was incorrect. In that 
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case, you’d need one button linking to the next slide, one linking to the slide after that, etc. On the slides 

showing the correct and incorrect responses, whichever slide comes last won’t need an action button. 

See Appendix 2 for a discussion on how to use macros with action buttons. 

You can also use Action Buttons to create games like Math Jeopardy and other games to enhance the 

lesson. 

Design Principles 

Contrast 

Effective use of contrast applies in so many elements of presentation 

design that it’s impossible to cover them all here. There are two main 

ways you can be effective with contrast, one rather basic and one 

specific to math. 

Design Template/Theme 

If you choose a design template with a dark background, the lighter a 

color you can choose for your text, the better the contrast will be, and the more readable your slides will 

be. The opposite is true for templates with a light background. Keep in mind that some in your audience 

will most likely be colorblind (according to a recent study, about 10% of American adults are), and the 

better the contrast, the better they’ll be able to read your slides, regardless of the colors you have 

chosen. 

Focus attention on part of an equation with a contrasting color 

This is something you can’t do with Equation Editor, since it won’t let you change color. With MathType 

though, you can change the color of your equations to match your text color in PowerPoint, and you can 

mix colors in a single equation if you’d like too. You don’t want a 

rainbow, of course, but let’s say for example you’re discussing solving 

quadratic equations, and are teaching the value of the discriminant. 

You might have the quadratic formula in a dark blue color to match 

the color of your PowerPoint font, but your discriminant could be 

bright red, making it show up in stark contrast. Something to keep in 

mind here is the colorblindness issue. Individuals who are colorblind 

most often have trouble with red and green, so don’t use color as the 

sole means of distinguishing part of an equation or expression. 

Alignment 

With this issue too, there are too many aspects to consider in a short 

handout, but let’s consider these… 

“Making use of contrast can help you 

create a design in which one item is 

clearly dominant. This helps the 

viewer “get” the point of your design 

quickly.” 

Garr Reynolds, Presentation Zen 

“Many people fail to make an effort 

to apply the alignment principle, 

which often results in elements being 

almost aligned but not quite. This 

may not seem like a big deal, but 

these kinds of slides look less 

sophisticated and overall less 

professional.” 

Garr Reynolds, Presentation Zen 



  
 

Rule of Thirds 

You’re no doubt familiar with the Golden Ratio. Art, architecture

cans are often designed with Golden Ratio proportions in mind. The idea is that these properties make 

the object more aesthetically pleasing

Closely related to, and derived from, the Golden Rat

paper (or canvas, or camera viewfinder, or whatever) into thirds, both vertically and horizontally, and 

you’ll have four “power points” (no pun intended, but it fits) at which to position the main subject 

maximum effect. Most of the time in a math lesson, your PowerPoint slides will not lend themselves to 

this type of positioning, but at times it will be useful to keep in mind. Consider th

This PowerPoint slide models the Rule of Thirds. The

points”, the equation of the hyperbola is one

statement is one-third up from the bottom of the slide.
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You’re no doubt familiar with the Golden Ratio. Art, architecture, and even objects as simple as soda 

cans are often designed with Golden Ratio proportions in mind. The idea is that these properties make 

the object more aesthetically pleasing—at least on a subconscious level. 

Closely related to, and derived from, the Golden Ratio is the Rule of Thirds. Very simply, divide your 

paper (or canvas, or camera viewfinder, or whatever) into thirds, both vertically and horizontally, and 

you’ll have four “power points” (no pun intended, but it fits) at which to position the main subject 

maximum effect. Most of the time in a math lesson, your PowerPoint slides will not lend themselves to 

this type of positioning, but at times it will be useful to keep in mind. Consider this slide

This PowerPoint slide models the Rule of Thirds. The center of the hyperbola is at one of the “power 

points”, the equation of the hyperbola is one-third down from the top of the slide, and the “congruent” 

third up from the bottom of the slide. 

en objects as simple as soda 

cans are often designed with Golden Ratio proportions in mind. The idea is that these properties make 

io is the Rule of Thirds. Very simply, divide your 

paper (or canvas, or camera viewfinder, or whatever) into thirds, both vertically and horizontally, and 

you’ll have four “power points” (no pun intended, but it fits) at which to position the main subject for 

maximum effect. Most of the time in a math lesson, your PowerPoint slides will not lend themselves to 

slide … 

 

center of the hyperbola is at one of the “power 

third down from the top of the slide, and the “congruent” 
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Alignment of equations 

Equation alignment is applicable to several different situations, but let’s consider two: step-by-step 

processes, and systems of equations/inequalities. 

Step-by-step processes 
You’ve seen the textbooks that show step-by-step how to solve an equation, factor a polynomial, or 

something else requiring multiple steps. They usually have the steps on the left with an explanation on 

the right. The example slides on Page 8 of this handout don’t show the only way to align items in this 

type of process, but it’s arguably the best way to do it. By aligning the relational operators in the stack of 

equations, students can more easily compare one step with the previous one. Left-justifying the 

explanations at some point on the right half of the slide is more or less an aesthetic move, but also 

provides an extra measure of readability. 

Systems of equations or inequalities 
In a system of equations, it’s necessary to compare one equation with another if you’re going to solve 

them algebraically. Consider these examples: 

 

3 4 17 3 4 17

4 4

2 3 2 15 2 3 2 15

x y z x y z

x y x y

x y z x y z

+
+ + = + + = 

 + = + = 
 + + = + + = 

Example 1 Example 2

 

For someone proficient in solving such systems algebraically, it’s no real challenge in either example to 

notice that a good first step would be to multiply the second equation by –3 or –4, or to multiply the 

first equation by –2. For someone not proficient in this type of solution, the first step is much easier to 

see if the equations are aligned as in Example 2. 

Presenter View 

PowerPoint has a very nice feature called Presenter View that I highly recommend. Presenter View is 

available both on Windows and Macintosh, and allows you to see a different display than what the 

students see. There will be some times when you won’t use Presenter View – such as when you’re not 

physically in front of your computer when you present the lesson – but it does provide some real 

advantages: 

• You can see the last slide you presented, the current slide, and the next slide in the deck. 

• In the Mac version, you can see the next animation. 

• You can see the Notes Pane. This allows you to put less information on the slide itself, making 

for a cleaner slide, and allowing the students to focus their attention on you rather than trying 

to read gobs of text on the slide. 

On the next page is a screen shot of Presenter View in PowerPoint 2004 on the Macintosh. 
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Turning Presenter View on and off 

Turning Presenter View on and off on the Mac is no big deal; in Preferences > Displays, just uncheck the 

“Mirror displays” box. On Windows, it’s more complicated. Select Control Panel > Display. In the Display  

Properties dialog, click on the Settings tab, click on the blue rectangle labeled 2, and check the box 

labeled “Extend my Windows desktop onto this monitor”. Click OK, and your monitors are ready for 

Presenter View. In PowerPoint, click Slide Show > Set Up Slide Show, and check the “Show Presenter 

View” checkbox. To turn off Presenter View, you don’t need to reverse all of these steps, just uncheck 

the “Extend my Windows desktop” checkbox on the Display Properties dialog. 

Conclusion 

Presenting math lessons with PowerPoint presents some unique challenges, but general rules of good 

design practice will almost always apply. Keep your slides simple and well-organized, and your students 

will find it much easier to grasp the lesson’s concepts because they won’t have to read your slide and 

listen to you at the same time. Part of “keeping it simple” is using animation and sound only when it 

enhances the lesson; overuse of these will detract from the message you’re trying to get across. 

Just as you should always be on the lookout for better teaching methods, you should also be seeking to 

increase your proficiency with PowerPoint. The resources listed in the Appendix of this handout are a 

good place to start. 

 



  
Page 18  

  

Appendix 1:  
Resources for using PowerPoint as a math or science teacher 

Websites 

1. Design Science website: 

! Tutorial: Using MathType with PowerPoint: www.dessci.com/ppt 
! Tutorial: Creating a PowerPoint Design Template: www.dessci.com/template 

2. Tutorials, tips, free templates:  www.indezine.com 

3. Tutorial: PowerPoint in the Classroom (not from Design Science): www.actden.com/pp2003 

4. Free backgrounds & templates: http://etc.usf.edu/presentations/index.html 
5. Pre-built PowerPoint lessons for Harcourt (gr. 3-5), McDougal Littell (6, Pre-Alg, Alg I, Alg II), 

Prentice Hall (Pre-Algebra & Algebra I): www.MathSlideShow.com 

Software 

1. Autograph: www.autograph-math.com 

2. WinPlot: www.peanutsoftware.com 

3. GCalc 3.1: www.gcalc.net 
4. Graph 4.3: www.padowan.dk/graph 

5. Clip art: 

! http://school.discovery.com/clipart (free) 

! www.clipart.com (not free) 

! http://office.microsoft.com/clipart (free) 

! http://etc.usf.edu/clipart (free) 

Blogs & Newsletters 

1. Design Science News: http://designscience.typepad.com/news 

2. Teaching Math with Technology: http://tcmtechnologyblog.blogspot.com 

3. PowerPoint Tips: www.ellenfinkelstein.com/powerpoint_tips_blog.html 
4. Indezine: www.indezine.com 

5. Presentation Zen: www.presentationzen.com 

Books 

1. PowerPoint for Teachers: http://www.amazon.com/gp/product/078799717X  
2. Cutting Edge PowerPoint for Dummies: http://www.amazon.com/gp/product/0764598171 

Miscellaneous 

1. For more information about color: www.colormatters.com 

2. Generate your own PowerPoint color schemes: www.defencemechanism.com/color 

3. For more information about contrast & colorblindness: www.vischeck.com 

4. Screen shots in this presentation created with Snagit: www.techsmith.com 

5. Interactive and motion paths examples from this presentation: 

For PowerPoint 2007: www.dessci.com/interactive07 

For all other versions: www.dessci.com/interactive 



  
 

 
Appendix 2: 
Using macros with action buttons to create an interactive quiz

For this example, let’s look at the same slide we used in the earlier discussion about action buttons:

Slides Pane (i.e., click on the Slides 

window), and use the shortcut key for 

the Macintosh, it’s "ÌD. If you don’t like shortcut keys, right

Duplicate Slide.  

Step 2: Create macros 

The reason this won’t work with PowerPoint 2008 is 

because Microsoft didn’t include Visual Basic for 

Applications (VBA) in Office 2008. If you’re using 

PowerPoint 2004 (Macintosh), see specific instructions 

Step 2a. Do this before following the steps below.

From the Tools menu, choose Macro > Visual Basic 

Editor. (PPT 2007, click on Visual Basic
section of the Developer tab on the Ribbon. If your 

Developer tab isn’t showing, click the 

the Popular section, click Show Developer tab in the Ribbon

We'll start with the code for the wrong answer.

type the following three lines: 
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with action buttons to create an interactive quiz (not PPT 2008)

For this example, let’s look at the same slide we used in the earlier discussion about action buttons:

Step 1: Create the question slide

The first step is to create the question slide, including 

not only the questions, but all of the responses as well. 

Create one action button for each of the responses, 

but don’t assign an action to it yet. (When the 

Settings dialog appears, just click Cancel for now.)

It’s a good idea now to create duplicates of this slide 

for however many questions you’re going

the quiz. If you’ll have 5 questions, create 4 duplicates. 

The easiest way to do that is to use the 

command. You can activate that command several 

ways, but the easiest way is to click on the slide
 tab in the Slides/Outline Pane on the left side of the PowerPoint 

window), and use the shortcut key for Duplicate Slide. In Windows, the shortcut key is 

D. If you don’t like shortcut keys, right-click (Mac ctrl+click) the slide and click on 

The reason this won’t work with PowerPoint 2008 is 

because Microsoft didn’t include Visual Basic for 

If you’re using 

PowerPoint 2004 (Macintosh), see specific instructions in 

following the steps below. 

From the Tools menu, choose Macro > Visual Basic 

Visual Basic in the Code 

section of the Developer tab on the Ribbon. If your 

Developer tab isn’t showing, click the Office button, then PowerPoint Options. In 

Show Developer tab in the Ribbon.) 

We'll start with the code for the wrong answer. In the big blank space on the right, 

PPT 2008) 

For this example, let’s look at the same slide we used in the earlier discussion about action buttons: 

Create the question slides 

The first step is to create the question slide, including 

not only the questions, but all of the responses as well. 

Create one action button for each of the responses, 

but don’t assign an action to it yet. (When the Action 

Settings dialog appears, just click Cancel for now.) 

It’s a good idea now to create duplicates of this slide 

for however many questions you’re going to have in 

the quiz. If you’ll have 5 questions, create 4 duplicates. 

to use the Duplicate Slide 

command. You can activate that command several 

click on the slide in the 

tab in the Slides/Outline Pane on the left side of the PowerPoint 

. In Windows, the shortcut key is Ctrl+D, and on 

ac ctrl+click) the slide and click on 
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Sub Wrong() 
MsgBox ("Sorry, that's not right. Please try again.") 
End Sub 

If you make a mistake, the editor will warn you, but the message may not be clear to you. Most often 

the mistake is a result of mistyping the code. You may have left out one of the quotation marks or the 

closing parenthesis at the end of a line. Double-check your typing and make adjustments until the Editor 

shows no warnings. 

Next is the code for the right answer. At the end of the line reading “End Sub,” press the ENTER key on 

your keyboard. This begins a new code group. Type the following four lines below your first code group: 

Sub Right() 
MsgBox ("That's right!") 
SlideShowWindows(1).View.Next 
End Sub 

This code is similar to the previous macro, except for its “SlideShowWindows” line, which advances the 

quiz-taker to the next slide. 

On the final slide, you don't want the slideshow to advance to the next slide because that starts the 

presentation all over again. Instead, you want viewers to use a button that exits the slideshow. So after 

the previous “End Sub,” hit the ENTER key again and type your final piece of code: 

Sub RightLast() 
MsgBox ("Congratulations!") 
End Sub 

This is what your set of 3 macros will look like now: 

 

Notice the 2 horizontal lines separating the 3 macros. This is something the Visual Basic Editor will 

include for you; you don’t need to add them yourself. 

  



  
 

Step 2a: If you’re using PowerPoint 2004

From the Tools menu, choose 

Macro > Visual Basic Editor. 

Two new panes will open 

up—the Projects pane and 

the Properties pane. Both of 

these panes should be totally empty, except for an item 

labeled VBAProject ([name of file])
and from the contextual menu that appears, hover over 

Insert, then choose Module, as shown in this screen shot. 

A new window labeled  

[name of file] – Module 1 (Code) will appear. It is in this 

window that you’ll type the lines of c

of the previous page. 

 

Step 3: Attach macros to buttons

To return to PowerPoint from the Visual Basic Editor, click on the 

(upper left-hand corner, under the FILE or 

the background. In PowerPoint, save the presentation, as this will save the new macros as well. (If 

you’re using PowerPoint 2007, be sure to save with a .pptm extension.) 

Go to your first question slide and select the action butto

button (Mac: ctrl+click) and choose 

choose Hyperlink). The Action Settings dialog box will appear. Choose the 

“Action on click” area, check the “Run macro” radio button and select your new “Right” macro from the 

drop-down list. (Notice that all the macros on this list are named for the three pieces of code you 

created in the Visual Basic Editor.) Click OK.

Now select each of the wrong answers and follow the same procedure, except select the “Wrong” 

macro from the drop-down list. 

Before going on to the other slides to assign the proper macros, try out the buttons on the first slide. 

Start the slide show. (Convenient Windows

beginning, or Shift+F5 to start the slide show from the current slide.) Click on a wrong answer. A 

message box should pop up indicating you have chosen the wrong answer. Click OK to close the box. 

Check the other wrong answers on the slide to make sure they also work. Finally, select the correct 

answer. This time, the message box should indicate you have chosen the right answer. Click OK and the 

slide show will automatically advance to the next slide.
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If you’re using PowerPoint 2004… 

these panes should be totally empty, except for an item 

VBAProject ([name of file]). Ctrl+click this item, 

and from the contextual menu that appears, hover over 

, as shown in this screen shot. 

will appear. It is in this 

window that you’ll type the lines of code shown at the top 

Step 3: Attach macros to buttons 

To return to PowerPoint from the Visual Basic Editor, click on the View Microsoft PowerPoint

hand corner, under the FILE or ! menu link). It’s OK to leave the Visual Basic Editor open in 

the background. In PowerPoint, save the presentation, as this will save the new macros as well. (If 

you’re using PowerPoint 2007, be sure to save with a .pptm extension.)  

Go to your first question slide and select the action button with the correct answer. Right

button (Mac: ctrl+click) and choose Action Settings from the contextual menu (in PowerPoint 2007, 

). The Action Settings dialog box will appear. Choose the Mouse Click
click” area, check the “Run macro” radio button and select your new “Right” macro from the 

down list. (Notice that all the macros on this list are named for the three pieces of code you 

created in the Visual Basic Editor.) Click OK. 

the wrong answers and follow the same procedure, except select the “Wrong” 

Before going on to the other slides to assign the proper macros, try out the buttons on the first slide. 

Windows keyboard shortcuts are F5 to start the slide show from the 

to start the slide show from the current slide.) Click on a wrong answer. A 

message box should pop up indicating you have chosen the wrong answer. Click OK to close the box. 

eck the other wrong answers on the slide to make sure they also work. Finally, select the correct 

answer. This time, the message box should indicate you have chosen the right answer. Click OK and the 

slide show will automatically advance to the next slide. 

View Microsoft PowerPoint icon 

ual Basic Editor open in 

the background. In PowerPoint, save the presentation, as this will save the new macros as well. (If 

n with the correct answer. Right-click the 

from the contextual menu (in PowerPoint 2007, 

Mouse Click tab, and from the 

click” area, check the “Run macro” radio button and select your new “Right” macro from the 

down list. (Notice that all the macros on this list are named for the three pieces of code you 

the wrong answers and follow the same procedure, except select the “Wrong” 

Before going on to the other slides to assign the proper macros, try out the buttons on the first slide. 

to start the slide show from the 

to start the slide show from the current slide.) Click on a wrong answer. A 

message box should pop up indicating you have chosen the wrong answer. Click OK to close the box. 

eck the other wrong answers on the slide to make sure they also work. Finally, select the correct 

answer. This time, the message box should indicate you have chosen the right answer. Click OK and the 
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With the first slide working properly, edit the rest of the presentation, attaching the appropriate macros 

to the buttons. On the last slide, assign the correct answer to the “RightLast” macro so that quiz-takers 

stay on the last slide. 

On your final quiz slide, you may want to create a button to end the slide show. Right-click on that 

button and choose Action Settings (PowerPoint 2007: Hyperlink). In the Action Settings dialog box, 

choose the Hyperlink to option and choose End Show from the drop-down list. Click OK. Quiz-takers can 

use this button when they're finished answering all the questions. Of course, if you’re using this “quiz” 

as a pre-lesson warm-up, your whole lesson is yet to come, so you won’t need an End button. 

Once you have assigned macros to all of the action buttons, save the PowerPoint file. 

Much of the text in Appendix 2 is taken from Ellen Finkelstein’s PowerPoint Tips website, and appears here with her 
permission. The URL for Ellen’s website is shown in the Blogs & Newsletters section of Appendix 1. Much of Ellen’s 
stuff is free, but two of her works are especially appropriate to mention here: 

• 101 Tips Every PowerPoint User Should Know – available from the website at 
http://www.ellenfinkelstein.com/estore/101tips2003.html 

• PowerPoint for Teachers – a book available through Amazon.com and elsewhere. Amazon URL for this 
book is listed in the Books section of Appendix 1 



RCEM APPROACH
• This approach was developed 

by the Regional College of 
Education, Mysore, 
Karnataka, India.



• RCEM consists of three 
aspects as follows :

• 1. INPUT
• 2. PROCESS
• 3. OUTCOME



RCEM-INPUT
• Input refers to the objectives 

of the plan. They are known 
as expected behavoiural
outcome. (EBO). They are 
clsiified into following 
categories :



EBO
• 1. KNOWLEDGE.
• 2. UNDERSTANDING.
• 3. APPLICATION.
• 4. ACTIVITY.



RCEM-PROCESS
• The process refers to the 

teaching strategies. They are:
• Communication strategy.
• Instructional aids.
• Learning situation.
• Technique of motivation



RCEM-OUTCOME
• Refers to the real learning 

outcome. This includes 
general and specific 
objectives.



RCEM FORMAT-LESSON 
PLAN

• Name of the teacher :
• Name of the subject :
• Name of the topic :
• Name of the unit :



• Class/Group/Batch :
• Size of the class :
• Data & Time :
• Venue :
• Previous knowledge :
• Method of teaching :



• AV aids :
• General objectives :

1.
2.

• Specific objectives :
1.
2.
3.



RCEM FORMAT
INSTRUCTIONAL 
OBJECTIVES

CONTENTS TEACHING 
ACTIVITY

LEARNING 
ACTIVITY

EVALUATION

General  & 
Specific 
objectives

•Intro
•Aims
•Presentation
•Explanation 
•Summary
•Assignment

•Explanation
•Clarification

• Listening
• Notes taking

•Recapitalization



Teacher’s Handbook 
 
CBSE has taken several initiatives towards qualitative improvement of education. Making 
every stakeholder- teacher, student, parent, principal, school management - feel 
responsible and a part of this improvement process is necessary. Simultaneously, it is felt 
that there should be a resource which contains all information related to each of these 
stakeholders at one place. With the focus on making students future-ready, it has been felt 
that in addition to being aware of the expectations from the teachers by the Board, our 
teachers must also be equipped with the information required by them regarding their 
learners and related to their career improvement and advancement. We believe that a well-
informed teacher can do wonders in a classroom. The present Handbook for Teachers is a 
source of information to teachers for the procedures, policies, roles, responsibilities, awards 
and resources related to their professional life. Beginning from basic information about 
appointment and qualification, this Handbook also contains a range of information, such as, 
teacher self-evaluation framework, details about the board examinations, subjects offered, 
use of technology, disaster management procedures to be followed, awards that teacher 
may apply for, and several other important and much-needed information about CBSE 
policies in the matters involving teachers. It is expected that this handbook will answer most 
queries pertaining to the professional lives of teachers with regard to their association with 
the CBSE.  
 



Textbook 
 
Introduction  
The mathematics text book is another important source for 
learning mathematics and it plays a key role in effective 
teaching and learning. Therefore it is important that these 
text books merely supplyinformation and facts, but also 
enable the student to understand and appreciate concepts 
and principles and their relevance in day to day life. A text 
book should stimulate reflective thinking and develop 
problem solving ability among students the text books should 
present real learning situations which are challenging and 
interesting for the students and should not render itself as a 
means of rote learning.  

NEED	AND	IMPORTANCE	OF	A	GOOD	
TEXT	BOOK	IN	MATHEMATICS	 
A mathematics text book is very useful for a teacher in the 
following ways.  

 

•  

A text book is written according to the syllabus and gives the 
outline of the course. Therefore it helps the teacher to 



decide about the limits and depth of the content to be 
presented to the students while teaching.  

• •  A text book provides insight to the teacher in planning 
lesson, in selecting the problems to be worked out, the 
methods of teaching to be adopted and the teaching 
aids to be used.  

• •  The logical and psychological sequence followed in a 
text book helps the teacher in presenting the subject 
matter in an orderly and systematic sequence  

• •  A good text book presents a variety of worked out 
examples on each topic. This helps the teacher in getting 
acquainted with different types of problems and the 
methods to solve them. This gives more self confidence 
while teaching  

• •  A text book save a lot of time for the teacher as he 
need not spend time to prepare problems and the 
solutions as they are readily available in the text books.  

• A text book is an important aid for learning mathematics. It 
helps the pupils to relate what they are learning to life.  

• It helps to foster the right study attitude among the 
students since the text book presents defined and concrete 
details in scientific and intensive manner which could arouse 
the students interest and curiosity.  

• The well graded exercises provided after every topic in the 
text book help the teacher in assigning suitable homework 
and assignment to the student.  

• •  It encourages self study and independent work among 
the students.  



• •  The text book provides important source of materials 
for reviewing and recapitulating the lessons taught in 
the class.  

Conclusion  

“ Few tools have been so misused as textbooks in 
teaching.” It will be no exaggeration to say that text 
book have become ends in education. The teachers 
follow them blindly. They are read out loudly, para by 
para in the class by each of the pupils in turn; brief 
explanations and comments are given by the teachers, 
and  

 

2  

the entire matter covered is to be memorized by the pupils in 
the class as well as at home. The text book is valuable only 
when it is used properly. The text book should not be used as 
the only source of instructional material. It should be used as 
an aid in teaching, not a substitute for teaching.  

 

 

 

 

QUALITIES OF A GOOD MATHEMATICS 
TEXTBOOK  



1. The appearance of the textbook should be appealing with 
an attractive cover page.  

2. The paper used in the textbook should be of superior 
quality.  

3. The printing should be bold and easily readable. 
4. The binding of the book should be strong and durable.  

5. The price should be moderate.  
6. It should have been written in accordance with the aims  

and objectives of teaching the subject in that particular  

class.  

7. It should be prepared according to prescribed syllabus and  

every aspect of the syllabus should be adequately covered. 
8.It should be written by qualified, experienced and 
competent teachers of mathematics or a committee of  

experts constituted for the purpose. 
9. It should be written in simple and easily understandable  

language and the presentation should be within the grasp  

of the pupils. 
10. The style and vocabulary used should be suitable to the  

age group of students for whom the book is written. 
11. It should relate classroom learning to the real life needs  

and physical and social environments of the learners.  



12. It should provide adequate opportunities to motivate the 
students to solve problems, by presenting an adequate 
number of worked out problems and problems that reflect 
daily life situations requiring the student to apply 
mathematical principles and formulae for their solution.  

13. It should foster the right attitude towards self-study and 
self-reliance among pupils by suggesting project work, field 
work and laboratory work.  

14. It should make provision for recapitulation of the subject 
taught in previous classes.  

15. The new development and invention in the field of 
mathematics should find their place in the textbook.  

16. It should facilitate the use of analytic, synthetic, 
inductive, deductive, problem-solving and heuristic 
approaches to teaching.  

17. It should provide accurate and up-to-date content. It 
should organize the content in the increasing order of 
difficulty.  

18. The content should have a direct, practical and social 
utility value.  

19. It should carefully organize the subject matter with 
reference to the logical as well as the psychological 
considerations which make teaching effective.  

20. The presentation of the subject matter must be attractive 
and interesting with appropriate illustrations in terms of  



pictures, diagrams and figures. The diagrams used in the text 
book should be easily recognizable and geometric 
constructions should be in proportion to the measurements 
prescribed by the problem.  

21. It should use the terms and symbols which are popular 
and internationally accepted. All the terms, concepts and 
principles used in the text should be clearly and accurately 
stated and defined.  

22. It should provide for individual differences. It should 
meet the needs of students of varying abilities, interests and 
attitudes.  

23. It should stimulate initiative and originality of the 
students. It should give well-graded exercises at the end of 
every topic to satisfy the needs of all types of students.  

24. It should contain some difficulty problems or exercises to 
challenge the mathematically gifted students.  

25. It should contain sufficient provision for revision, practice 
and review. It should satisfy the demands of examination.  
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b. 11 INTRODUCTION 

ou would agree that success of any activity depends largely upon its planning. 
rop;er planning of activities leads to fruitful results. The same is true with teaching k 
s well. As a teacher you are given charge of a certain class to teach mathenlatics. 
o ybu have to cover the given course in the available time span and also ensure 
ffedtive learning amongst children. Now tbe challenge is to do it successfully. 1 hisvery idea may generate thinking with regard to sequencing, ordering. arranging 

and grouping the items of the curriculuin, matching these with the available time 
slot bnd identifying suitable activities t o  be perfomled with children etc. This is 
nothing but planning for teaching. 

You b a y  plan teaching in various ways. Firstly you inay develop a rough layout 
for the whole year in which you may decide before and how ruuch time you 
woulld devote to various topics or units in the curriculun~. Secondly you may like 
to ddvelop a detailed planning of the separate units of work where in you may 
decide the number of lessons for each seginent of work along with the method or 
approach to deal wit11 them. Thirdly you may like to go into details of activities 
pert4ining to each lesson. So the planning for teaching involvcs the process of 
makibg decisions about why, how and what to teach whicll may range one 
lessdin to the whole curriculum for the year. In this unit we will discuss the various 
aspects of unit and lesson planning in mathematics. 

~ f t e i  going through this unit, you will be able to : 

a qecognize the need and Ilnportailce of unit and lesson pla~lning: 
I 

llst various steps involved ill unit planning; 



develop a unit plan for teaching of a given unit; U n i t  and Lesson P l a n n i n g  

enlist variot~s steps of !esson planning; and 

develop lesscn plans for teaching lessons in mathematics. 

2.3 UNIT PLANNING 

'The curriculum of matliematics may be available to you in terms of either content1 
concepts or competencies. Your target would, therefore, be to ensure acquisition 
of certain understanding and skills among children with regard to dealing with 
mathematical content and processes. In other words you may intend to develop 
mathematical competencies amongst children under vour charge. You may recall 
that i n  tlie document titled, "Mininium Levels of Learning at Primary Stage" 
(Ministry of Human Resource Development report published by the NCERT, 
1991) the necessary competencies have been listed i~nder five nla-jor areas of 
matheniatical learning. Further classwise arrangement of competencies is also 
available within each area. Since there would be q long list of compete~iciesl 
prescribed for each class unit planning may be of great help to you in guiding your 
actions leading to success. The following sub-sections cover tlie meaning of unit 
planning, necd a12d importance of ~lnit  planning and the process of developi~ig the 
unit plans. 

2.3.1 Meaning of Unit Planning 

Let us first understand what do we mean by a unit in niatheinatics. A unit i n  
mathematics comprises of a chunk of interlinl<ed competencieslconceptslcontcnt 
which liave some common basis or characteristics. So, within any area of 
matliematical learning several ~lnits can be formed. It is tlie nature hfcompetencies 
content and the experience of the teacher about teaclling mathematics and his1 
her perception of learning styles of children which will enable Iiimlher to decide 
about formulating the units. 

Now you will appreciate that teacher has to organize the given set of competencies1 
content prescribed for the given class in a meaningful manner which will make 
his/!ier teaching and evalt~at ion systematic and convenient. A illlit in mathematics 
may be cavcrecl in one day, several days or even several wecks. You will have to 
decide the number of lessons to be delivered under one unit. 

Having arranged tlie mathematical conipetencies in a graded manner and divided 
them into t~nits for purposes of classroom transaction, you would like to think of 
the ways of communicating tlie same to tlie children. 'This will obviously make 
you think of the sequence of lessons within a unit, tlie method of teaching 
instr~~ctional aids, students' activities and the evaluation procedures. This decision 
if presentcd in an organized manner, would result into a unit plan, 

2.3.2 Need and Importance of Unit Planning 

You may like tb ask why we need a unit plan or can't we do without a unit plan? 
Tlie answer is siniple that unit planning may bring about significant changes in the 
quality ofteacliing-learning. Tlie foIlowi~~gpoi~its highlight the advantages of unit 
planning and tli~is clarify how i ~ n i t  planning makes teachers talk easier and effective: 

It helps teachers to liave a holistic view of teacliing-learn'ag, which may 
help in organizing time and resources availab!e at hisl'her disposal. 

It liclps in  des;gning a systematic, sequential and graded arrangement cf  course 
content which may give inslgl~t to develop teacl~ii:g activities in rhe best 
pcss~ble Iiianner. 



Curriculun~ P ~ ~ I I I I ~ I I ~  ~ I I J  It helps in giving a balanced emphasis to various aspects of course content 
Ins truct io~~  in 
Mathematics or competency under reference. 

It provides arn opportunitj to correlate textual content with the competencies 
to be dealt with in the class. 

It may help thiilki~ig about alternative approaches to teaching-learning and 
adapt to individual differences. 

It may help unit-wise evaluation of childre11 and in organizing remedial teaching 
and undertaking enrichment measures as per the iequirements. 

2.3.3 Steps Involved in Unit Planning 

Uqit planning involves two major processes, namely, sequencing and selection. 
The main focus of unit planning should be to ensure effective learning on the part 
ofchildren. After arranging the given set of con~petencies/content into a teaching- 
ledrning sequence, a unit can be formed on the basis of identification of meaningfill 
se$ments of competencies/content which may also be viewed In terms of time 
avbilable for teaching-learning. Some people divide the course content to be 
covered month-wise and call them 'units'. Still more important is the nature of 
course content or competencies and, as such, some units inay be small and some 
big in terms of time taken for teaching them. So a teacher has to apply judgment. 
Since we can not l a v e  the whole thing on intuilive ways of fonnulzting units, 
some steps to be followed are suggested below: 

a) Estiinate the whole course content/set of competencies for the class during 
I the year. 

b) Estimate the teaching time available to the teachers. 

c )  Arrange the given coursz content /set of competencies in a teaching-learning 
sequence. 

d) Identify inter-linked aspects of course content /competencies. . 
e )  Distribute the whole course content/compe?encies into units. Hence you may 

I like to consider the following: 

i) A unit should not be too small or too lengthy 

ii) It should have some element of commonness within its conlponents. 

iii) It should be such that it should not reqllire more than a month in any case 
to complete in the class, and 

iv) It should be such that its completion develops a sense of accon~plishl*lent 
to both the teacher and the students. 

f) For each listed unit, further breaking up of teaching lessons would be required. 

g) For each lessoil within the unit, decide about the appropriate teaching methods, 
teaching aids, students activities and the evaluation procedure. 

h)i Present these decisions and the break-up in a tabular form which may be 
considered to be unit plan. 

23.4 Development of Unit Plan 

Development of unit plan may be atternpled differently by differmt peoplz. But 
the developrncnt a f  competency among children sliould be the ma111 peint to be 
k$pt in mind uhiIe developing a unit plan. One way of looking at unlt planning 
could be to do it trred wise thc nurr:ber of competenaes listed 111 each area for a 

n" 
cl$ss which arc to bc raught in abo:lt ten rconths duration. So theoreiiczi!y speaking, 



there should be at least five units, each concentrating on one of the areas. But it 
will not be a practical way of doing things since there may be a large number of 
competencies in an area. So further break-up would be necessary. Although it 
sliould not be taken as tlie norm but for practical reasons there should not be 
more than 10 competencies in an area and it should not be planned to be taught in 
inore than 20 working days. Tire similarity in the nature of content involved in 
coinpetencies identified for a linit should also be given due consideration. Now 
various lessons may be planned within a unit and points related to organization of 
teaching-learning may be drawn as suggested. The followilig example of a unit 
plan may give you an idea of the format and particulars of a unit plan : 

UNIT PLAN 

Unit Plan No ........................ Name of the Teacher ........................ 

Subject - Mathematics 

Area - 1 (understanding whole numbers and numerals) 

Co~iipetencies Covered: 1.3.1 (Recognition and writing of numerals from 100 
to 1000.) 

1.3.2 (Writing of nulnber names from 1 to 100.) 

S. Competency 1,csson Methodof '  Teaching Students Eval~lation 
No. No. Teaching aids Activies 

1 .  1.3. I .  (a) Recognizes 1 to 3 play' way method Flash cards Various gah~es Oral testing 
numerals from and demonstration and group work 
100 to  999 

(b) Recognizes 3 -do- -do- -do- -do- 
numeral 1000 

(c) Writes numerals 4 -do- -do- Ind~vidual and Oral as well. 
from 100 to 1000 group activities as written 

2. I .3 .2  Writing of 5 and 6 -do- -do - -do- Oral and 
number names fro111 written test 
1 to 1000 

2.3.5 Limitations of Unit Planning 

\VIii!e unit planning is of much value to teachers it may suffer fro111 the limitations 
mentioned below: 

It is solnetinies difficult to clearly anticipate the teaching-learning approach 
in advance. 

The division of co~~tel i t  / colnpetencies is artificial. 

It gives a piecenieal view of tlie competencies developed during a year. 

I requires a conscious effort on the part of a teacher. A less experienced 
teacher sometimes find It difficult to plan units. 

a It puts a check to the flexibility of the teacher when followed rigidly. 

/ Checli Your PI-ogress I 
Notes:  a)  Write !,our answers i n  the space given below.. 

b) Co!nparr: your answer wit11 the one given at the end of this unit. 
I 

Unit  and Lesson Planning 



C u r r i c u l u ~ n  F l n ~ ~ ~ ~ i n g  a n d  
[nstruct ion in  
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2.4 LESSON PLANNING 

According to G.H. Green, the teacher who has planned h isllier lesson wisely, 
related to his/her topic and to his classroo~n without any anxiety is ready to ernbark 
with confidence upon a job s/he understands and is prepared to carry it to a 
workab~le concl~~sion.  Slhe has foreseen the difficulties that are likely to arise and 
prepared her/hi~nself to deal with them. Slhe knows the aims that Iier/his lessoll 
i s  intended to fclfill and s/he has identified herlhis own resources for the purpose. 
And because s/he is free of anxiety, slhe will be able to estimate the value of her/ 
his work as the lesson proceeds, equally aware of failure and success and prepared 
to learn from both. The following paragraphs have been devoted to the meaning, 
need and importance of lesson planning and the process of developing lesson 
plans. 

A proper planning of the lesson is the key to effective teaching. The teacher 
must kuow in  advance the sub.iect matter and the mode of its del i~ery In the 
classroom This gives the teacher an idea of how to develop the key concepts 
and how to correlate them to real-life situatio~is and how to conclude the lesson. 
Lesson pianning is also essential because effectike learning takes place only if 
the subject matter is yrewnted i~ an integrdted and correlated manner and is 
related to the pupil's environment. Though lesson planning requires hard work it 
is rewarding too. It conceives a lesson as 'Plan of Action' in~plen~ented by the 
teacher i n  the classroom 

2.4.1 Meaning of Lesson Planning 

A iesson plan outlines in detail the various steps wl~icli the teacher proposes to 
undertake in his1 her class. As such, a lesson plan concerns itself with the teaching 
of one period. Planning for a lesscn means identification of the sequence and 
style of presentation and evaluation procedure to be adopted for classroo~n teaching 
of a lesson. Hence it is a proposition in advance which establishes a linkage 
between the why, what arid how ~f teaching in one period. Wh!le attempting to 
do this the teacher may foresee likely pmb!oms i n  classroom cnmmu~~ication and 
may arrange ~er ta ln  mnteria!~ and c!c,idr 311011t recliniqi~es to be adopted to ensure 
a smooth and effective teaching-ieal!?;r!g rr?i~alibn. Thus a lesson pian IS  a means 
of tnking advallce decisions about t!ie sr::ct~on, sequencing and execution of 
varlous activ'ties to be perfor~ned En a ciassroorn with a view to ensuring learning 
of children. 



2.4.2 Need and Importance of Lesson Planning Uni t  and Lessun Ylanni~lg' 

When you go for teaching a lesson in the classroom, usually you get prepared for 
~ t ,  though informally. But sometimes you find that you are not able to teach the 
entire content which you prepared or on the other hand, the content to be covered 
is not sufficient for full period. Sometime, you may get stuck-up while teaching 
and so get nervous. May be that you are not aware of the objectives of teaching 
a lesson and so did not bother about its attainment. How to overcome all such 
problems') This can be done through systeinatic lesson planning. You get a chance 
of thinking about all these problems in advance while planning your lesson and 
deciding about taking corrective steps for possible hurdles. The process of 
developing a les'son plan is such that these problems get tackled automatically. 

Lesson planning helps the teacher in the following ways: 

a It makes teaching systematic and well organized. 

a It helps teachers in identifying adequate content and its proper sequencing 
for teaching a lesson. 

a It helps teachers to learn to foresee and tackle learning difficulties of children. 

a It enables teachers to utilize the available time properly. 

It helps in developing insights about learning needs and abilities of children. 
s \ 

a It helps teachers to develop the habit of undertaking immediate corrective 
measures. 

It gives confidence to teachers during teaching. 

2.4.3 Steps of Lesson Planning 

While develop~ng a lessoil plan. first of all you have to decide about the objectives 
of teaching that particular lesson. The objectives will be both general as well as 
specific. In order to achieve the objectives. some subject matter or content is 
required. This content is to be selected as per the competence with reference to 
the specific objectives of the lesson as well as the previous knowledge of the 
learner So the content has to be local spec~fic, interesting and related to the 
previous knowledge of the learner. Another iillporta~lt aspect of lesson planning 
is to detail out the inethod to be used for transacting the required material to the 
learners. The choice of method will depend on the nature of the content. the 
classtgrade as well as the ability of the learners. While specifying the method of 
delivery, the teachers' activities as well as the learners' activities are to be 
specified along with the evaluation exercisestquestions. The evaluation has to be 
based on the material transacted in the classroon~ and the competency aimed to 
be developed. At the primary stage, the evaluation questions have to be very 
simple. keeping In vlew the learners7 physical and mental growth 

The following issues need to be decided for developing a lesson plan. 

I Objectives: The object~ves of teaching a particular lesson should be stated 
as per the competency to be developed anloilgst children. Generally teachers 
state only general,and specific objectives of the lesson. 

2 .  Content: The subject matter that is intended to be covered should be limited 
to the prescribed time. The matter must be interesting and it should be related 
to the pupils' previous knowledge. It should also be related to daily life 
situations. 

3. Methods: The nlost appropriate method be chosen by the teacher. The 
method selected, should be suitable to the subject matter to be taught. Suitable 

t teaching aids must also be identified by the teacher. The teacher may also 
use supplementary aids to inake histher lesson lllore effective. 
- - - -  - 



4 Evaluation: A tcachei inust c\.al~inte Ii~slher less011 to find the extent to 
which hetshe has achieved the objectives of liislher lesson Evali~ation can 
be done even by recapitulat~oii of subject matter through su~table qucstlons 

2.4.,4 Methods of Lesson Planning 

A legson nlay be planned in various nrays Several methods haw.  therefore. been 
evolved The most conl~nonly used method is tlie Herbert~an method The steps 
follawed in Herbertian method of lesson p lann~ns  are. 

1. introduction 

2. Presentation 

3 .  Association (or co~l~parison) 

4. Generalization 

5 .  Application 

6. Recapitulation. and 

7. Home assignment I hoine work 

1 .  Ihtroduction 

It peaalns to preparing and nlotivating children to the lesson content b!. 11iiking it 
to the previous knowledge of the student. by arousing the curios~ty of the chtldren 
and b$ making <an appeal to  their senses This prepares the'child's iniiid to receive 
new bowledge.  This step, though so important. must be brief. It may involve 
testin4 of prevlous knowledge of the child. Sonietiines tlic curiosity of pupil can 
be aroused b!, sonit: experiment. chart, nlodel study or even by some useful 
discushion. 

I 

2. Pitesentation 

It iilvdlvcs stating tlie object of the lesson and exposure of students to ne\\ 
infornihtion The actual lesson beg~ns  and both teacher and students partlclpatc 
A tcacljcr should niake use of different teaching aids to make this lesson effective 
She/He; should draw as much as is possible fro111 the students makin2 use of 
judicio~ls questions. In matheinatics lessons It is desirable that a heuristic 
atmosphere prevails 111 the class. 

3. Askociation 

It 1s aliYa3.s desirable that new ideas or knowledge be associated to the dai i~l  life 
s~tu,atioils by cl t~ng su~table esa~nples and by dm~iltilg comparisons n.it11 tlie related 
concepti; miis step is all the more important when we are establish~tzg princ~ples 
or genet~lizing definit~o~ls 

In itlath$matics lcssons generally the learning mater~al probleiii [cads to certain 
genemiitations which then lead to the establishment of certain foriiiulac. solv~ng 
problem$. principles and Ialvs An effort should be madethat the s t u d r ~ ~ t s  dran 
t l ~ c  condluslons themselves. A teacher should guide the students only if their 
gcncraliiatlon IS either incoinpletc or ~ r r c l c ~ ~ n n t  

I11 this stkp of a lesson plan the knowledge gained is applied to cortain siti~atio~ls. 
This stcpl is in conformity \\.it11 the gcileral desire of the students to mnkc use of 
gencml~z~ t ion  in order to see for tlienisel\.es if the generakations arc \,atid 111 

eortaan si/tuations or not. This is uscd for assessing tllc cffccti\,cncss of tlic lcsson 
b!. a&in$ studcnts questions on the contents of tlic I c s so~~ .  

I 



Recapitulation can be done by giving a short objective type testlproblem solving 
method to the class. 

One important poi111 to remember is that the steps given above for lesson planning 
are formal Herbertiari steps and teaclier sliould not try to follow these very rigidly. 
These are only guide-lines and in many lessons it is not possible to follow all these 
steps. So this method s l~o i~ ld  be followed to the extent possible. 

2.4.5 Features of a Good Lesson Plan 

1.  Through less011 planning tlie teacher will be able t i  pinpoint for himself the 
objective;; of teaching that particular lesson. The objectives should be sucli 
that they are . (a) attainable during a span of one period only. (b) in sequence 
with the objectives already attained by tlie learners. 

2. The teacher will discover whether tlie subject m'atter is adequate enougli to 
be transacted during the period. 

3.  He will identify, in advance, tlie activities to be carried out by tlie learners. 

3. He will be able to anticipate the expected answers of tlie learners. 

5 .  A good lesson plan sliould present good linkage between tlie objectives, teacher 
and student activities. on tlie one hand and the method, tlie teaching aid and 
tlie e\faluation itenis on tlie othel-. 

6 .  Tlie plan should neither be too short tior too long. 

7. It should focus 011 specific piece of content so as to  attain the competency i n  
hand. 

8. The activilies planned slioi~ld be quite interesting to the young learners. 

9. It should focus O I I  the development of a clear ~~nderstanding alnong children 
instead of rote ~iie~iiorization. 

2.4.6 Develop~nent of it Lesson Plan 

Keeping in view tlie steps of lesson planning and tlie ~netllods discussed in tlie 
preceding sections, lesson plans may be developed. Tlie followingexa~nples will 
de~no~istrate some approaches to lesson planning. You may learn to develop lesson 
plans by adapting these to the competency in hand and the anticipated teaching- 
lean1 ing situatio~~. 

LESSON PLAN - 1 

Name of School : XYZ ' Date: 10/8/2002 

Class : I I l  

Sub.ject : Mathe~-natics Period: II 

.Topic : Place \talue of Competency: Studelits state the place value 
3 d ig~ t  i i~~mbers  ofthe digits witliin a 3 ctig~t numeral. 

General objectives o f  tlic lesson : 7'0 develop understa~id~~ig of tlie place 
value of tlie digits in nunlel-als. 

Specific objccti\cs oftlle I ~ S S O I I  , Stl~cic~lts \ \ i l l  be able to slate place value 
oftlie digits \+it1ii11 a 3 digit n~~~i ic t -a l .  

I C I I ~ I I ~ S I I - I ~  I i t 1  : or~linary classrooni niatc~ial. 

7 7 



spike abacus. C u r r i c u l u n ~  I 'launing a n d  
I n s t r u c t i o n  i n  
Ma thema t i c s  a chart showing 3 digit numbers marked 

as units, tens and hundreds. 

I flash card containing 3 digit numbers. 

rev 1 ous knowledge : i) Students recognize and write numbers 
I 1 to 1000 

ii) Students state the place value of digits in 
a 2 digit number. 

iii) Students write number names of 3 digit 
I 

numbers. 

Intrioduction 

Tea$her will put some questions to the students: 
(writing a few two digit numbers on tlie blackboard.) 

I .  What are the numbers written on the blackboard? 

2. l n  24, which number represents units? 

3. 1n 24, which number represents tens? 

4. What  is the place value of numeral 4 in 24. 

5 .  What is the place value of numeral 2 in 24? 
'(Teacher may ask similar cluestions for the numerals 40 and 39.) 

6. What is tlie place value of 2 in 246. 
(Writing number 246 on the blackboard.) (No answer) 

I 

Statement of aim: Children, today we will study tlie place value of numerals in a 
3 dilgit numbers. 

Teacher-Pupil Activity 
I 

I 

(Slibwing tile flash card containing 3 digit numbers.) 
I 

1. What nl~meral is shown on the flash card ? 

2. Write tlie number name for this number (246) 

(Two Hundred Forty Six) 

(Covering the nuliieral2) 

3. Wliat is tlie numeral left now'? 

(Forty Six) 

' (Showing the flash card again) 

4. Wliat numeral is there on tlie third place from right side? 

5 .  What additional you had to say for 246 as con~pared to 46? A 



i 
I 

Teachers' Statement 

(So you liavc to say two hundred because of the numerals 2's placement at 3rd 
place from the right. Hence the place value of 2 in 246 is 200.) 

Teacher will now take 3-4 exa~iiples of 3 d ~ g ~ t  nuliibers and get tlie place value 
chart filled In with tlie involvenient of students. 

3 d~glt  Place values 
Nunierals 

Hundreds Tens Units 

Nu~neral Place Nunieral Place Nunieral Place 
Value Value Value 

90 8 9 900 0 00 8 8 

Tlie chart will be further discussed using flash cards if children find it difficult. 
Another explanatory chart can be developed through students involvement as 
under: 

3 digit Place value 
Numerals 

1 3rd place from right 2nd place fro111 right 1 st place from right 

Nu- Place Place Nu- Place Place No- Place Place 
11iera1 value nleral value 111ercll value 

785 7 Hundred 7~100=700 8 Tens 8x10=80 5 Unit 5xl=5 

462 4 Hundred 4x100=400 6 Tcns 6x10=60 2 Unit 2x1=2 

407 4 Hundred 4x100=400 0 Tens Ox lO=OO 7 Unit 7x1=7 

I 
370 3 Hundred 3x100=300 7 Tens 7x10=70 0 Ul~it Ox1=0 

1 Generalization 

I Teacher to assist children in generalizing, on the basis of above examples. tlie 

I following: 

i 
I i) Place value of the digit in 1 st place fro111 right side is the number represented 

by the digit itself. 

ii) Place value of tlie digit ill  2nd place from right side is the digit multiplied by 
i l o ,  

1 iii) Place value of the digit in 3rd place from r~glit side is the d~gi t  multiplied by 
1 100. 

i \ )  Tlie place valuc of the dlgit in n numcrnl incrcascs ten timcs as we move 
from r~glit to left. 

Place value of 2 in 12 is 2 I 



~ u r r i r ~ r l u r n  I ' l r l ~ ~ ~ i n g  ant1 Recapitulation 
I n s t r u c t i o n  i n  
R l a t h e o i r t i c t  1. What is the place value of 3 in 138? 

2. What is the place value of 3 in 13? 

3. What is the place value of 3 in 347? 

4. State the place values of numerals in 754. 

1 Numeral Place value 

Home Wmk 

State tlie place values of the digits in tlie following 3 digit numerals 393,408,790. 
456. 
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LESSON PLAN - 2 

Name of School: XYZ Date: 1011 198 

Class: V Duration: 40 Minutes 

Subject: Mathematics 

~ o i i c :  Volume of cuboid 

Period: Third 

Competency: Students compute the volume of a cuboid. 

Ge~~era l  objective of tlie lesson: To develop the thiiikilig and reasoning powers of 
the students. 

Spe~cific objectives: i) Students understand the concept of voli~me. 

ii) Students find tlie formula of the volume of cuboid. 

iii) Students apply tlie formula of tlie volu~ne of cuboid to 
relevant problems. 

Teaching/Instructional Material 

1 .  Ordinary classroo~n ~iiaterials 

2. O n e  dm cube of wood or any solid material 

3. A chart showing diagrams of square and rectangle 

4. T W O  c~~bo.ids with different di~nelisions 

5 .  A tin of cuboidal shape 

6. A graduated cylinder 

7. One centimeter cube piece of some solid 

Preyious Knowledge 

e ,-. rl-lie students know the concept of areas of square and rectangle. 



Introduction Unit all11 Lesson Plall l l i l~g 

To test their previous knowledge and to prepare them for the new lessons, the 
following questions will be put to them: 

1. (By showing the diagram of a square in the chart) 
How do you calculate the area of this diagram'? 

2. (By showing the diagram of a rectangle) 
How will you calculate the area of this diagram'? 

3. (By showing the tin) 
If you have to say that this tin can contain so nluch oil, how can you 
express? 

4. Similarly, if you want to say that a tank can contain so much of water, how 
can you express? 

5 .  What is the space of a tin or a tank'? 

6. (By showing the cuboid) 
How would you nane this solid? 

7. How will you find out the space or volume of this cuboid? 

Statement of the Aim 

The student will not be able to qilswer the last question and the teacher will 
announce. "Today we shall find out the method of calculating the volume of a 
cuboid". The aim will be simultaneously written on the blackboard. 

Presentation 

Teacher - Pupil Activity 

1. By showing the 1 cm. cube. 1 . What are the dimensions of the solid'? 

(Long, broad and thick) 2. What is its shape'? 

3. 'What is the difference between a cube 
and a cuboid '? 

Pupil- Teacher Statements: 

"It is known as a cube. The cube has all 
the three dimensions uniform, whereas 
in the cuboid these may be different." 

4. What is the volume of this cube'? 
Pupil-Teacher Statement: 

"Let us measure it with the help of a 
graduated cylinder" The initial reading 
of the water level will be taken and then 
the solid will be immersed. 
The water will rise by one cubic 
centimetre. 

5 .  What are the dinlensions of this cube? 

Ans.: Length = 1 cm 
Breadth = 1 cm 

Thickness or Height = 1 cm 

6 .  What is the volume of this cube'? 

Ans. : It is one cubic centinletre (One @ 

cubic centimeter is taken as the units of 
volume). 

3 1 

By showing the 1 cm. cube 



By s11~wing t+jle cuboid of soap 7. What are the dimensions of this cuboid? 

Ans: Length - 5 cnl 
Breadth = 3 cm 
Thickness or Heigl~t = 2 cm 

8. In  how Inally parts have its length, 
breadth and thickness respectively been 
divided? 

Ans.: i) The length is divided into 5 
parts. 

ii) The breadth is divided into 3 
parts. 

iii) The thickness is divided into 
2 parts. 

(Tl~e teacher will promptly cut 
this cuboid alongwith lines of 
divisim. It will result'into 30 
parts.) ................................ ( i )  

9. What is the shape of each small part? 

Ans.: It is cube. 
10. What js the dimensions of this small . cube? 

I Ans.: Length = l cm 

Breadth = 1 c m  
Thickness = 1 cm 

rV 1 1. What is the volu~ne of this small cube? 
Ans.: lt is one ~ u b i c  cm 

This cube will be compared with 
the cuboid already shown to the 
students- 

12. What is the volume of the whole cuboid? 
A!ls. : The volume of the c~~ob id  = 30 

cubic cm .............................. (ii) 
By d~dwinp the second caboid of 13. What are fhe dimensions of the cuboid? 

soap Ans.: Length ='6 cm 
Breadti3 = 4cm 

Ti~ickness or Height = 2 c p  
( ~ i r n i l a i l ~  it will result in 48 small 
parts)., .............................. , ........ ( i i i )  

14. What is the vqlume of one small cube? 
Ans.: It i s  one cubic cm. 

15, How many ';such cubes are there in all? 
Ans.: There are 48 such cubes. 

16. What is tf>e volume of the whole cuboid? 
Ans.: The volume of the cuboid i s  

...................... 48 uibie cm (iv) 

GeaerFiization 

For the, purpose of generalization, the teacher will draw the studen,tas attention to 
the parts (i), (ii), (iii) and (iv) and will ask them to observe these to frndout.some 
relationship between the dimensions and the volu~nes of cuboids, 



1. What are the dimensio~is in the first case? Length = 5 crn [ I n i t  H I I ~  Less011 IBlanniaag 

Breadtli = 3 cm 
Height or thickness = 2 cm 

2. What is the volume in  this case? Volume = 30 cubic cm. 

3 .  What are the dimensions i n  the Length = 6 cm 
- second case? Breadth = 4 cm 

Height or Thickness = 2 cm 

4. What is the volu~ne i n  this case? Volume = 48 cubic crn. 

5 .  What is the relation between the Volume is the product of 
volume and dimensions? these three dimensions. 

Dimensim ofcuboid Volu~ne of Cuboid 

Length Bread t11 Height 

5 cm 3 cm 2 cm 5 x 3 x 2 = 30 cu.cm 

6 cni 4 cm 2 cm 6 ,x  4 x 2 = 48 cu.cm 

There Volt~me of Cuboid = Length x Breadtli x Height or Tliickness or 
L x B x H or 'r. 

Blackboard Summary 

1. The cuboid has all the three dimensions: 

a) Length 

b) Breadtli 

c) Height or Thickness 

2. Volume of a cuboid 

= Length x Lengtli x Heiglit or Thickness 
C 

Relation 
f 

1 .  What is the use of finding out the volume of air in a room? 

Ans :While sitting in  a room tlie person sliould get a regular supply of fresh air. 
The mi~ii~num essential volume of air should be available to everybody. With 
the help of total volume of air in a room, a classroo~n or a hall, we can f ix its 
co~nfortable seating capacity. If we try to acco~ii~nodate more than tliis 
fixed number, this will be uncomfortable and suffocating for.every body. 

1 .  What do you mean by volume? 

2. What is tlie difference between a cube and a cuboid? 

3 .  What is the formula for tlie volume of a cuboid? 

4, Wliat is the need of finding out v o l u ~ ~ b  in different cases? 

Home Work 

1. What is tlie volume of air ill your classroom, if its dimensions are as follows: 

a )  Length = 5 Metres 

b) Breadth = 4 Metres + % : ~2~%/~+:e r; 

c)  I-leight = 3 .5  Metres * 

33 * 



C u r r i c u l u m  P l a n n i n g  a n d  2. Find the volume of water in a tank if its dimensions are as follows: 
I n s t r u c t i o n  i n  
M a t l ~ e m a t i c s  a) Length = 350 cm. 

b) Breadth = 200 cm. 

c )  Depth = 100 cm. 

The examples given above will help you develop insights into the process and 
procedure of lesson planning. You may plan your activities in a variety of ways 
wherein children sliould be able to learn things in an interesting manner. 

2.4.7 Limitations of Lesson Planning 

You would have seen that lesson planning provides an opportunity to the teacher 
to thi~mk i n  advance about the sequence of likely classroom events and anticipate 
tlie pobsible problems and sort them out before the actual delivery of thc lesson. 
Yet lekon planning has its own limitations. Afew are mentioned below: 

It makes teaching organized but rigid. 

If followed strictly, it leaves no room for innovative~~ess 011 the part of the 
teacher. 

Tbo much of emphasis on it may make things routinized. 

I t  is good for beginner teachers. Experienced teachers usually have little 
fa,ith in structured classroom beliaviours. 

It is difficult to anticipate all possible kinds of classrooln situations in advance 
add therefore lesson plans lack relevance. 

The above mentioned limitations however, do not suggest that lesson planning is 
of no value. The only caution reflected through the above statements is that it 
should be developed carefully and experience counts for much. It may be noted 
that detailed lesson planning may be practiced in the beginning and brief lesson 
plannibg shoi~ld serve as an indispensable tool in the hands of a teacher throughout 
hislher career as a teacher. 

) C'lscclb I'our Progress 
i I I 
I Piotcs: a) Write !.t)~ir ; ~ I : s w ~ ~ s  in  the spacc giveii be lo !~ .  1 

i 

I < 
i " I  

hlention three ways in \ ~ h i i h  lesson plailning helps !he teacl~cls .  ' 
1 

............................................................................................................ 1 ~ 
! 



2.5 LET US SUM UP Unit and Lesson Plai ining 

After going through the preceding sections you would be able to appreciate the 
need and importance of unit and lesson planning and also the inethodology of 
developing unit and lesson plans. Unit and Lesson Plans do help teachers in 
organizing their actions in advance and help them undertake teaching in an 
interesting and efficient manner. If planned properly, unit and lesson plans may 
lead to better quality of learning amongst children. It is, therefore, important for 
every teacher to develop a habit of unit and lesson planning and keep doing it 
throughout hidher teaching career. Greater details may be required in the beginning 
while brief plans may be followed there after. 

2.6 UNIT-END EXERCISES 
* 

1. Explain the difference between a unit and a lesson plan. 

2. List the important steps of unit planning. 

3. List the important steps of lesson planning. 

4. Discuss the advantage and limitations of lesson planning. 

ANSWERS TO CHECK YOUR PROGRESS 

1. A unit plan is the statement of proposed decisions taken about teaching- 
learning and evaluation of a segment of inter-linked content/competencies. 

2. a systematic and balanced way of teaching various concepts, 

a evaluating pupils'progress, and 

a the proper n~anagemellt of time and resources. 

3. i) The division of content /competencies is artificial. 

ii) It inay put n check on flexibility of teachers if followed rigidly. 

4. Lesson plan is a detailed statenlent of proposed actions with regard to  
classroom activity particularly the selection, sequencing and execution of 
activities to be performed during a period to ensure learning amongst children. 

5. i) It helps teachers to identify the relevant content and its sequencing. 

ii) It helps teachers to foresee the learning difficulties of children. 

iii) It helps to develop cdnfidence amongst teachers. 

6. i) It brings rigidity in teaching-learning. 

ii) It leaves no room for teacher's innovativeness 
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